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Preface

This guide describes Device Fault Manager (DFM), provides instructions for 
installing DFM on a Windows system, and offers quick-start steps on the use of 
DFM. 

Audience
This document is for anyone who installs and initially uses DFM.

Conventions
This document uses the following conventions:

Item Convention

Commands and keywords boldface font

Variables for which you supply values italic font

Displayed session and system information screen font

Information you enter boldface screen font

Variables you enter italic screen font

Menu items and button names boldface font
xi
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Preface
  Product Documentation
Note Means reader take note. Notes contain helpful suggestions or references to 
material not covered in the publication. 

Caution Means reader be careful. In this situation, you might do something that could 
result in equipment damage or loss of data.

Product Documentation

Note We sometimes update the printed and electronic documentation after original 
publication. Therefore, you should also review the documentation on Cisco.com 
for any updates.

Table 1 describes the product documentation that is available.

Selecting a menu item in paragraphs Option > Network Preferences

Selecting a menu item in tables Option > Network Preferences

Item Convention
xii
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  Related Documentation
Related Documentation

Note We sometimes update the printed and electronic documentation after original 
publication. Therefore, you should also review the documentation on Cisco.com 
for any updates.

Table 1 Product Documentation

Document Title Available Formats

Release Notes for Device Fault 
Manager 2.0 on Windows

• Printed document that was included with the product.

• On Cisco.com at the following URL:

http://www.cisco.com/univercd/cc/td/doc/product/rtrmgmt/
cw2000/dfm/dfm20/rel_note/index.htm

Installation and Setup Guide for 
Device Fault Manager on Windows

• PDF on the product CD-ROM.

• On Cisco.com at the following URL:

http://www.cisco.com/univercd/cc/td/doc/product/rtrmgmt/
cw2000/dfm/dfm20/install/index.htm

• Printed document available by order (part number 
DOC-7816267=).1

1. See Obtaining Documentation, page xvi.

User Guide for Device Fault 
Manager

• PDF on the product CD-ROM.

• On Cisco.com at the following URL:

http://www.cisco.com/univercd/cc/td/doc/product/rtrmgmt/
cw2000/dfm/dfm2_0/ug/index.htm

• Printed document available by order (part number 
DOC-7816266=).1

Supported Device Table for 
DFM 2.0

• On Cisco.com at the following URL:

http://www.cisco.com/univercd/cc/td/doc/product/rtrmgmt/
cw2000/dfm/dev_sup/index.htm

Context-sensitive online help • Click Help.
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  Related Documentation
Table 2 describes the additional documentation that is available.

Table 2 Related Documentation

Document Title Available Formats

Quick Start Guide for LAN 
Management Solution 2.5 

• Printed document that was included with the product.

• On Cisco.com at the following URL:

http://www.cisco.com/univercd/cc/td/doc/product/rtrmgmt/
cw2000/cw2000_b/lms/index.htm

Release Notes for CiscoWorks 
Common Services 3.0 (Includes 
CiscoView 6.1) on Windows 

• Printed document that was included with the product.

• On Cisco.com at the following URL:

http://www.cisco.com/univercd/cc/td/doc/product/rtrmgmt/
cw2000/cw2000_d/comser30/relnotes/index.htm

Installation and Setup Guide for 
Common Services (Includes 
CiscoView) on Windows 

• PDF on the product CD-ROM.

• On Cisco.com at the following URL:

http://www.cisco.com/univercd/cc/td/doc/product/rtrmgmt/
cw2000/cw2000_d/comser30/ig_win/index.htm

• Printed document available by order (part number 
DOC-7816497=).1

1. See Obtaining Documentation, page xvi.

User Guide for CiscoWorks 
Common Services 

• PDF on the product CD-ROM.

• On Cisco.com at the following URL:

http://www.cisco.com/univercd/cc/td/doc/product/rtrmgmt/
cw2000/cw2000_d/comser30/usrguide/index.htm 

• Printed document available by order (part number 
DOC-7816571=).1
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  Additional Information Online
Additional Information Online

Note We have adopted a new system for naming and numbering our patch/IDUs. For all 
releases after DFM 2.0 Patch/IDU 2.0.1, we will use the following conventions: 
Patch/IDUs will be called Service Packs, and instead of version x.y.z, it will be 
called version z. For example, instead of DFM 2.0 Patch/IDU 2.0.2, a release 
would be called DFM 2.0 Service Pack 2.

Incremental Device Updates (IDUs) or service packs provide additional support 
for Cisco devices that were not supported when Device Fault Manager was 
released. When a new IDU/service pack is available, you can download it in one 
of the following ways:

• From Cisco.com:

1. Log into Cisco.com at the following URL:

http://www.cisco.com/cgi-bin/tablebuild.pl/cw2000-dfm.

2. Follow instructions online for downloading the IDU/service pack and the 
accompanying Readme. 

• From the CiscoWorks home page: 

1. From the CiscoWorks home page, select Common Services > Software 
Center > Software Update. The Software Updates window opens. 

2. See User Guide for CiscoWorks Common Services for how to configure 
and use Software Center.

Note You cannot download DFM IDUs/service packs using the following 
Software Center options: Device Update and Scheduled Device 
Download. 
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  Obtaining Documentation
IDUs/service packs are cumulative; that is, new IDUs/service packs contain the 
contents of any previous IDUs/service packs. To determine which version of an 
IDU/service pack is installed on your CiscoWorks Server:

1. In the CiscoWorks window, select Common Services > Software Center > 
Software Update. The Software Updates window opens. 

2. Click Device Fault Manager in the Products Installed table. The Details of 
the Applications, Packages installed window opens.

3. Check the version of DFMI in the Packages Installed table.

Obtaining Documentation
Cisco documentation and additional literature are available on Cisco.com. Cisco 
also provides several ways to obtain technical assistance and other technical 
resources. These sections explain how to obtain technical information from Cisco 
Systems.

Cisco.com
You can access the most current Cisco documentation at this URL:

http://www.cisco.com/univercd/home/home.htm

You can access the Cisco website at this URL:

http://www.cisco.com

You can access international Cisco websites at this URL:

http://www.cisco.com/public/countries_languages.shtml

Ordering Documentation
You can find instructions for ordering documentation at this URL:

http://www.cisco.com/univercd/cc/td/doc/es_inpck/pdi.htm
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  Documentation Feedback
You can order Cisco documentation in these ways:

• Registered Cisco.com users (Cisco direct customers) can order Cisco product 
documentation from the Ordering tool:

http://www.cisco.com/en/US/partner/ordering/index.shtml

• Nonregistered Cisco.com users can order documentation through a local 
account representative by calling Cisco Systems Corporate Headquarters 
(California, USA) at 408 526-7208 or, elsewhere in North America, by 
calling 1 800 553-NETS (6387).

Documentation Feedback
You can send comments about technical documentation to bug-doc@cisco.com.

You can submit comments by using the response card (if present) behind the front 
cover of your document or by writing to the following address:

Cisco Systems
Attn: Customer Document Ordering
170 West Tasman Drive
San Jose, CA 95134-9883

We appreciate your comments.

Obtaining Technical Assistance
For all customers, partners, resellers, and distributors who hold valid Cisco 
service contracts, Cisco Technical Support provides 24-hour-a-day, 
award-winning technical assistance. The Cisco Technical Support Website on 
Cisco.com features extensive online support resources. In addition, Cisco 
Technical Assistance Center (TAC) engineers provide telephone support. If you 
do not hold a valid Cisco service contract, contact your reseller.
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  Obtaining Technical Assistance
Cisco Technical Support Website
The Cisco Technical Support Website provides online documents and tools for 
troubleshooting and resolving technical issues with Cisco products and 
technologies. The website is available 24 hours a day, 365 days a year, at this 
URL:

http://www.cisco.com/techsupport

Access to all tools on the Cisco Technical Support Website requires a Cisco.com 
user ID and password. If you have a valid service contract but do not have a user 
ID or password, you can register at this URL:

http://tools.cisco.com/RPF/register/register.do

Note Use the Cisco Product Identification (CPI) tool to locate your product serial 
number before submitting a web or phone request for service. You can access the 
CPI tool from the Cisco Technical Support Website by clicking the Tools & 
Resources link under Documentation & Tools. Choose Cisco Product 
Identification Tool from the Alphabetical Index drop-down list, or click the 
Cisco Product Identification Tool link under Alerts & RMAs. The CPI tool 
offers three search options: by product ID or model name; by tree view; or for 
certain products, by copying and pasting show command output. Search results 
show an illustration of your product with the serial number label location 
highlighted. Locate the serial number label on your product and record the 
information before placing a service call.

Submitting a Service Request
Using the online TAC Service Request Tool is the fastest way to open S3 and S4 
service requests. (S3 and S4 service requests are those in which your network is 
minimally impaired or for which you require product information.) After you 
describe your situation, the TAC Service Request Tool provides recommended 
solutions. If your issue is not resolved using the recommended resources, your 
service request is assigned to a Cisco TAC engineer. The TAC Service Request 
Tool is located at this URL:

http://www.cisco.com/techsupport/servicerequest
xviii
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  Obtaining Technical Assistance
For S1 or S2 service requests or if you do not have Internet access, contact the 
Cisco TAC by telephone. (S1 or S2 service requests are those in which your 
production network is down or severely degraded.) Cisco TAC engineers are 
assigned immediately to S1 and S2 service requests to help keep your business 
operations running smoothly.

To open a service request by telephone, use one of the following numbers:

Asia-Pacific: +61 2 8446 7411 (Australia: 1 800 805 227)
EMEA: +32 2 704 55 55
USA: 1 800 553-2447

For a complete list of Cisco TAC contacts, go to this URL:

http://www.cisco.com/techsupport/contacts

Definitions of Service Request Severity
To ensure that all service requests are reported in a standard format, Cisco has 
established severity definitions.

Severity 1 (S1)—Your network is “down,” or there is a critical impact to your 
business operations. You and Cisco will commit all necessary resources around 
the clock to resolve the situation. 

Severity 2 (S2)—Operation of an existing network is severely degraded, or 
significant aspects of your business operation are negatively affected by 
inadequate performance of Cisco products. You and Cisco will commit full-time 
resources during normal business hours to resolve the situation.

Severity 3 (S3)—Operational performance of your network is impaired, but most 
business operations remain functional. You and Cisco will commit resources 
during normal business hours to restore service to satisfactory levels.

Severity 4 (S4)—You require information or assistance with Cisco product 
capabilities, installation, or configuration. There is little or no effect on your 
business operations.
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Obtaining Additional Publications and Information
Information about Cisco products, technologies, and network solutions is 
available from various online and printed sources.

• Cisco Marketplace provides a variety of Cisco books, reference guides, and 
logo merchandise. Visit Cisco Marketplace, the company store, at this URL:

http://www.cisco.com/go/marketplace/

• The Cisco Product Catalog describes the networking products offered by 
Cisco Systems, as well as ordering and customer support services. Access the 
Cisco Product Catalog at this URL:

http://cisco.com/univercd/cc/td/doc/pcat/

• Cisco Press publishes a wide range of general networking, training and 
certification titles. Both new and experienced users will benefit from these 
publications. For current Cisco Press titles and other information, go to Cisco 
Press at this URL:

http://www.ciscopress.com

• Packet magazine is the Cisco Systems technical user magazine for 
maximizing Internet and networking investments. Each quarter, Packet 
delivers coverage of the latest industry trends, technology breakthroughs, and 
Cisco products and solutions, as well as network deployment and 
troubleshooting tips, configuration examples, customer case studies, 
certification and training information, and links to scores of in-depth online 
resources. You can access Packet magazine at this URL:

http://www.cisco.com/packet

• iQ Magazine is the quarterly publication from Cisco Systems designed to 
help growing companies learn how they can use technology to increase 
revenue, streamline their business, and expand services. The publication 
identifies the challenges facing these companies and the technologies to help 
solve them, using real-world case studies and business strategies to help 
readers make sound technology investment decisions. You can access iQ 
Magazine at this URL:

http://www.cisco.com/go/iqmagazine
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• Internet Protocol Journal is a quarterly journal published by Cisco Systems 
for engineering professionals involved in designing, developing, and 
operating public and private internets and intranets. You can access the 
Internet Protocol Journal at this URL:

http://www.cisco.com/ipj

• World-class networking training is available from Cisco. You can view 
current offerings at this URL:

http://www.cisco.com/en/US/learning/index.html
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C H A P T E R 1

Prerequisites

This chapter describes the prerequisites for installing Device Fault Manager 
(DFM) on a Windows system. It includes:

• Product Overview, page 1-1

• Installation and Upgrade Paths, page 1-3

• Server Requirements and Recommendations, page 1-7

• Client Requirements, page 1-10

• Supported NMS Environments for Device Import, page 1-11

• Supported NMS Integration, page 1-13

• Supported Devices, page 1-14

Product Overview
Device Fault Manager is a network management and analytical tool that enables 
you to monitor your network devices and determine the cause of device problems. 
Table 1-1 describes installation options that are displayed under different 
circumstances and lists the DFM components that can be installed in each case.
1-1
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Table 1-1 DFM Installation Options and Their Components

Installation Option Installation Option Components

Device Fault Manager 2.0 This option is available when DFM 2.0 has not been installed on the 
local system. It is normally chosen to install the entire DFM product 
on the local system, including: 

• DFM—Provides the graphical user interface (GUI) and back-end 
processes for DFM. 

• HPOV-NetView adapters for integrating DFM with 
HP OpenView and NetView, if already installed on the same box.

Device Fault Manager 
HPOV-NetView adapters

This option is available whether or not DFM 2.0 is already installed 
on the local system. However, when this option is selected, it will 
install only the HPOV-NetView adapters, not the entire DFM product.

This option is normally chosen to install the adapters on a remote 
machine running HP OpenView or NetView, to forward traps from 
these remote network management systems (NMSs) to a local DFM. 
For information on how to configure and start these adapters, see 
Installing and Upgrading HPOV-NetView Adapters, page 2-13.
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Installation and Upgrade Paths
This section outlines the steps for installing and upgrading DFM 2.0. 

Installation Paths
You must install DFM 2.0 on a system with CiscoWorks Common Services 3.0. 
You can install DFM 2.0 on a system with:

• CiscoWorks only (as a “standalone” DFM)

• Common Services and any of the following:

– Other CiscoWorks applications, such as Campus Manager and Resource 
Manager Essentials (RME) that are included in a Cisco product bundle.

Note If you are installing DFM with the contents of a Cisco product 
bundle, see the quick start guide for the appropriate bundle for 
the order in which to install each product in the bundle. 

– Another NMS, such as NetView or HP OpenView.

Before you install DFM, you should determine whether you will install DFM as a 
standalone or with other products. For more information, see Server 
Requirements and Recommendations, page 1-7. 

Whether DFM is installed as a standalone or not, you can integrate it with:

• Other CiscoWorks applications from a Cisco product bundle to share a Device 
and Credentials Repository (DCR). For more information, see Supported 
NMS Environments for Device Import, page 1-11.

• Another NMS to receive SNMP traps from it. For more information, see 
Supported NMS Integration, page 1-13.
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Table 1-2 lists the basic installation sequence.

Table 1-2 Installation Roadmap

Description References

Step 1 Install Common Services. Installation and Setup Guide for 
Common Services (Includes 
CiscoView) on Windows

Step 2 If you want to install DFM on a system with an NMS 
(HP OpenView or NetView), install the NMS.

Note If the desired NMS is not installed before DFM, 
you will have to reinstall DFM later (after you 
install the NMS).

• For supported versions of 
NMSs, see Supported NMS 
Integration, page 1-13

• For installation instructions, 
see vendor documentation

Step 3 If you want to install DFM on a system with the contents 
of a Cisco product bundle:

a. Check the quick start guide for the order of 
installation.

b. Install any products that should be installed before 
DFM.

Quick Start Guide for LAN 
Management Solution 2.5 

Step 4 Install DFM.

Note If you are using Access Control Server (ACS) 
mode for your security, you will be warned that 
if you configured any custom ACS roles, they 
will be lost unless you exit the installation and 
change the AAA security mode to CiscoWorks 
Local. You should revert to ACS mode when the 
installation is completed.

Performing a New Installation, 
page 2-4

Step 5 If HP OpenView or NetView is installed on a remote 
system and you want DFM to receive SNMP traps from 
one of them, install or upgrade the HPOV-NetView 
adapters on the remote system.

• Installing and Upgrading 
HPOV-NetView Adapters, 
page 2-13

• Integrating DFM Trap 
Receiving with NMSs or Trap 
Daemons, page 4-15
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Upgrade Paths
You must upgrade DFM 2.0 on a system with Common Services 3.0. You can 
perform a local in-place upgrade from DFM 1.2.x or a remote upgrade. (For more 
information, see Upgrading to DFM 2.0, page 3-7.)

After the upgrade, whether DFM 2.0 is installed as a standalone or not, you can 
integrate it with:

• Other CiscoWorks applications from a Cisco product bundle to share a Device 
and Credentials Repository (DCR). For more information, see Supported 
NMS Environments for Device Import, page 1-11.

• Another NMS to receive SNMP traps from it. For more information, see 
Supported NMS Integration, page 1-13.

Step 6 If HP OpenView or NetView is installed on the same 
system as DFM and uses the standard UDP trap port 
(162), you must configure DFM SNMP trap receiving to 
use a different UDP port, such as port 9000. 

Configuring SNMP Trap 
Receiving and Forwarding, 
page 4-12.

Step 7 If you want a standalone DFM to access the DCR on a 
remote system (to share the device list across 
applications from a Cisco product bundle): 

a. Configure DCR on one system (local or remote) as 
a master.

b. Configure DCR on the other system as a slave. 

• Supported NMS 
Environments for Device 
Import, page 1-11

• Managing Device Credentials, 
page 4-5

Table 1-2 Installation Roadmap (continued)

Description References
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Table 1-3 lists the basic upgrade sequence.

Table 1-3 Upgrade Roadmap

Description References

Step 1 Upgrade Common Services.

Note If you must upgrade your operating system, do 
so before upgrading Common Services. 

Installation and Setup Guide for 
Common Services (Includes 
CiscoView) on Windows

Step 2 If you want to upgrade DFM on a system with an NMS 
(HP OpenView or NetView), do one of the following:

• If the NMS is already installed, determine whether 
to upgrade it and do so if required.

• Install the NMS.

Note If the NMS is not installed before DFM, you will 
have to reinstall DFM later (after you upgrade or 
install the NMS).

• For supported versions of 
NMSs, see Supported NMS 
Integration, page 1-13

• For installation instructions, 
see vendor documentation

Step 3 If you want to upgrade DFM on a system with the 
contents of a Cisco product bundle:

a. Check the quick start guide for the order of 
installation.

b. Install any products that should be installed before 
DFM.

Quick Start Guide for LAN 
Management Solution 2.5 
(Maintenance Kit)

Step 4 Upgrade DFM.

Note If you are performing a remote upgrade, you may 
want to download the DFM Upgrade Kit from 
Cisco.com.

Note If you are using ACS mode for your security, you 
will be warned that if you configured any custom 
ACS roles, they will be lost unless you exit the 
installation and change the AAA security mode 
to CiscoWorks Local. You should revert to ACS 
mode when the installation is completed.

Upgrading to DFM 2.0, page 3-7

Remote Upgrade, page 3-5

Upgrading to DFM 2.0, page 3-7
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Server Requirements and Recommendations
This section describes the server requirements and recommendations for Common 
Services and DFM 2.0. 

Note If you are installing DFM with the contents of a Cisco product bundle, the server 
requirements might be different. See the quick start guide for the appropriate 
bundle for additional information.

Step 5 If HP OpenView or NetView is installed on a remote 
system and you want DFM to receive SNMP traps from 
one of them, install or upgrade the HPOV-NetView 
adapters on the remote system.

• Installing and Upgrading 
HPOV-NetView Adapters, 
page 2-13

• Integrating DFM Trap 
Receiving with NMSs or Trap 
Daemons, page 4-15

Step 6 If HP OpenView or NetView is installed on the same 
system as DFM and uses the standard UDP trap port 
(162), you must configure DFM SNMP trap receiving to 
use a different UDP port, such as port 9000. 

Configuring SNMP Trap 
Receiving and Forwarding, 
page 4-12.

Step 7 If you want a standalone DFM to access the DCR on a 
remote system (to share the device list across 
applications from a Cisco product bundle): 

a. Configure DCR on one system (local or remote) as 
a master.

b. Configure DCR on the other system as a slave. 

• Supported NMS 
Environments for Device 
Import, page 1-11

• Managing Device Credentials, 
page 4-5

Table 1-3 Upgrade Roadmap (continued)

Description References
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Minimum Server Requirements
The minimum system requirements for a CiscoWorks Server running Common 
Services 3.0 and Device Fault Manager 2.0 are shown in Table 1-4. 

Table 1-4 Server System Minimum Requirements

Requirement Type Minimum Requirements

System hardware • IBM PC-compatible dual CPU system with 1.6 GHz or faster Pentium 
processor.

• 17-inch color monitor.

• CD-ROM drive.

System software • ODBC Driver Manager1 3.5.10.

• One of the following:

– Windows Server 2003 Standard and Enterprise Editions.

– Windows 2000 (Professional, Server, and Advanced Server) with Service 
Pack 3 or Service Pack 4.

Note Windows terminal services is supported in remote administration mode 
only. 

Note DFM supports only US-English and Japanese language versions. Set the 
default locale to US-English for the US-English version and Japanese for 
the Japanese version.

Available 
memory (RAM)

2 GB.

Available drive 
space

• 4 GB.

• Swap space equal to double the amount of memory (RAM). For example, if 
your system has 2 GB of RAM, you need 4 GB of swap space.

Note NTFS file system required for secure operation.
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Server Recommendations
To select or configure a server system that best meets your needs, consider the 
number of ports and interfaces being managed. (For the maximum number of 
ports and interfaces, see Number of Ports/Interfaces that DFM Supports, 
page 1-15.)

Note If you choose to automatically synchronize DFM device inventory with the 
Common Services Device and Credentials Repository (DCR) and the 
synchronization causes DFM to exceed the limits, DFM stops adding devices to 
the managed inventory. (See Supported NMS Environments for Device Import, 
page 1-11.)

To find out how many trunk and access ports and interfaces are currently imported 
into DFM, use the sm_tpmgr command:

# NMSROOT/objects/smarts/bin/sm_tpmgr --server=DFM --sizes

For ports, locate the line that is similar to the following:

Number of Ports: 761 [92/92]

Additional 
required software

Common Services must be installed before you install DFM. For installation 
instructions, see Installation and Setup Guide for Common Services (Includes 
CiscoView) on Windows.

Additional 
optional software

To use the desktop on the server system, you need one of the following browsers:

• Microsoft Internet Explorer 6.0 with SP1 (Java Virtual Machine (JVM) 
5.0.0.3802 and later and Java Plug-in version 1.4.2_04). 

• Netscape Navigator 7.1.

• Mozilla 1.7.1.

1. To verify the version of ODBC Driver Manager, from the Windows desktop, select Start > Settings > Control Panel > 
Administrative Tools > Data Sources (ODBC). Select the About tab. If necessary, install Microsoft Data Access 
Component (MDAC) 2.5 or later. 

Table 1-4 Server System Minimum Requirements (continued)

Requirement Type Minimum Requirements
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In this example, 761 represents the number of discovered ports, out of which 92 
are managed. Unless you have reconfigured DFM to manage access ports, you can 
assume these 92 ports are trunk ports.

For interfaces, locate the line that is similar to the following:

Number of Interfaces: 351 [322/280]

In this example, 351 represents the number of discovered interfaces, out of which 
322 are managed.

Client Requirements
The minimum system requirements for the CiscoWorks client are shown in 
Table 1-5.

Before you access DFM from a client system, you must configure the system. For 
more information about client system requirements and configuring clients, see 
Installation and Setup Guide for Common Services (Includes CiscoView) on 
Windows.

Table 1-5 Client System Requirements Summary

Requirement Type Minimum Requirements

System hardware and 
software

• One of the following client systems:

– IBM PC-compatible system with at least a 1 GHz Pentium processor 
running Windows 2000 (Professional and Server) with Service 
Pack 31 or Service Pack 4; Windows XP with Service Pack 1 or 
Service Pack 2; or Windows Server 2003 Standard or Enterprise 
Edition without terminal services.

– Sun SPARC Ultra 10 running Solaris 2.8 or 2.9.

DFM supports only US-English and Japanese versions of Windows 
Operating System (OS) and Solaris OS. Set the default locale to 
US-English for the US-English OS, and Japanese for the Japanese OS.

• Color monitor with video card set to 24 bits color depth.

Available memory 
(RAM)

512 MB.
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Supported NMS Environments for Device Import 
DFM device inventory is taken from the Common Services Device and 
Credentials Repository (DCR). DCR is a common repository of devices, their 
attributes, and credentials. It is the central place where users add or import new 
devices. 

Available disk apace 1 GB swap space.

Note Swap space should be equal to twice the amount of RAM.

Browser One of these browsers:

• On Windows clients:

– Microsoft Internet Explorer 6.0 with Service Pack 1, Java Virtual 
Machine (JVM) 5.0.0.3802 and later, and (optional) Java Plug-in 
version 1.4.2_04.

To verify the JVM:
From Internet Explorer, select View > Java Console.
From Netscape Navigator, select Tools > Server > Java Console.

– Netscape Navigator 7.1 for Windows.

– Mozilla 1.7.1.

• On Solaris clients:

– Netscape Navigator 7.0 for Solaris 2.8 and 2.9.

– Mozilla 1.7 for Solaris 2.8 and 2.9.

For Solaris, use Netscape Navigator downloaded from the Sun website only.

1. To verify the existing service pack, from the Start menu, select Run and enter winver.

Table 1-5 Client System Requirements Summary (continued)

Requirement Type Minimum Requirements
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DCR enables you to share devices lists with other applications as follows: 

• Using DCR, you can import devices from:

– A local network management system (NMS)—Common Services 
supports import from NetView and HP OpenView. For supported 
versions, see Supported NMS Integration, page 1-13. 

– A remote NMS—The same NMSs supported locally are supported 
remotely. 

– A file—File can be exported from another product and formatted for 
import to DCR. 

• You can configure a DCR server to host a master list of all devices and share 
the list with clients (other instances of DCR in the same management domain 
that are configured as slaves).

By default, DFM is configured to automatically synchronize its device list with 
DCR. If the synchronization causes the DFM system to exceed its limit, the device 
and credentials list will be truncated. (See Number of Ports/Interfaces that DFM 
Supports, page 1-15.)

Alternatively, you can configure DFM to allow only manual selection of devices 
in DCR that you want DFM to manage. When you do so, DFM displays a list of 
devices in DCR, but not in DFM, for you to choose from.

The following scenarios illustrate only a few possible ways to configure DFM and 
DCR to share device lists and credentials.

Scenario One

In this scenario, DFM and RME are installed on separate systems. On the RME 
system, DCR is configured as a server (master). On the DFM system, DCR is 
configured as a client (slave) of the DCR server on the RME system. The DFM 
system is configured for manual selection devices from DCR.

In this scenario, devices imported to the DCR server on the RME system are also 
added to the DCR client on the DFM system. Since DFM is not configured to 
automatically synchronize with DCR, the devices are not added to the DFM 
inventory. However, these devices are available in DCR and if DFM users want to 
manage them, they can do so by selecting them. 
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Scenario Two

In this scenario, DFM and an NMS are installed on the same system. DCR is 
configured to run bulk import regularly, importing devices from a local NMS. 
DFM is configured to synchronize with DCR. 

In this scenario, DCR regularly imports devices from the local NMS, updating 
DCR with any new devices. Since DFM is configured to automatically 
synchronize with DCR, the devices are also added to the DFM inventory. 

Note Synchronization with DCR will stop when DFM reaches its limit. See Number of 
Ports/Interfaces that DFM Supports, page 1-15.

Supported NMS Integration
DFM supports integration with network management systems (NMSs) as follows:

• DFM listens for traps from managed devices on port 162 (the default). If 
another NMS on the system with DFM uses port 162:

– The installation script warns you that this is the case. 

– You must specify a different port for DFM trap receiving after the 
installation completes. See Integrating DFM Trap Receiving with NMSs 
or Trap Daemons, page 4-15.

• DFM forwards traps to destinations that you specify, as follows:

– To forward pass-through traps, see Configuring SNMP Trap Receiving 
and Forwarding, page 4-12. 

– To forward processed traps, see “Managing SNMP Trap Notifications” in 
the “Using Notification Services” chapter of User Guide for Device Fault 
Manager.

For more information on pass-through and processed traps, see the appendix 
“Processed and Pass-through Traps, and Other Unidentified Traps and 
Events” in User Guide for Device Fault Manager.
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• DFM provides the HPOV-NetView adapters, which forwards traps (sent from 
managed devices to the NMS) to DFM from remote or local hosts running:

– HP OpenView 6.4 and 7.0.1

– NetView 7.1 and 7.1.4

For remote machines without CiscoWorks, the remote adapters are supported 
on:

– Solaris 2.8 or 2.9

– Windows 2000 Server and Advanced Server with SP 4

– Windows Server 2003 Limited and Enterprise Edition 

Installing these adapters on remote machines is described in Installing and 
Upgrading HPOV-NetView Adapters, page 2-13.

Note To use the HPOV-NetView adapters with a local version of 
HP OpenView or NetView, make sure that HP OpenView or NetView 
is installed before you install DFM.

If the standard User Datagram Protocol (UDP) trap port (162) is being used by 
another NMS, you must configure DFM SNMP trap receiving to use a different 
UDP port, such as port 9000. See Configuring SNMP Trap Receiving and 
Forwarding, page 4-12.

Supported Devices
Device adapter packages for all supported devices are installed when you install 
DFM. Information about devices installed with DFM can be found at:

http://www.cisco.com/univercd/cc/td/doc/product/rtrmgmt/cw2000/DFM/ 
dev_sup/index.htm

For information on how device support compares between DFM 1.2.x and 
DFM 2.0, see Release Notes for Device Fault Manager 2.0 at this URL:

http://www.cisco.com/univercd/cc/td/doc/product/rtrmgmt/cw2000/dfm/dfm20
/rel_note/index.htm.
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As additional device adapter packages become available, you can download the 
IDUs that contain them, by logging into Cisco.com at:

http://www.cisco.com/cgi-bin/tablebuild.pl/cw2000-DFM

Number of Ports/Interfaces that DFM Supports
DFM supports configurations of up to 45,000 ports/interfaces, of which 6,750 (or 
15%) are managed. This support was tested with an average of 30 ports/interfaces 
per device.

If you have an unrestricted license, DFM stops adding devices to its managed 
inventory when the supported number of ports/interfaces on the devices is 
reached. 

If you have a restricted license, however, DFM stops adding devices to its 
managed inventory after the number of devices in managed inventory equals or 
surpasses the number of devices specified by the license. DFM displays licensing 
reminders as the number of devices nears the limit; see Restricted Version: Device 
Limit Exceeded, page A-5.
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Installing and Uninstalling DFM

This chapter describes installing Device Fault Manager (DFM) on a Windows 
system. It includes:

• Preparing to Install DFM, page 2-1

• Performing a New Installation, page 2-4

• Reinstalling DFM, page 2-10

• Uninstalling DFM, page 2-13

• Installing and Upgrading HPOV-NetView Adapters, page 2-13

• Removing the HPOV-Netview Adapters, page 2-17

Preparing to Install DFM
The sections that follow help you to perform the following tasks before you install 
DFM:

• Determine whether your existing applications are already using ports that 
DFM uses. (Existing applications should not use the ports that DFM uses.)

• Gather information that you might need to provide during the DFM 
installation.
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Verifying TCP and UDP Ports that DFM Uses
Before installing DFM, make sure that the ports DFM uses will be used only by 
applications listed in Table 2-1. For a complete list of ports used by Common 
Services and other LAN Management Solution (LMS) applications, see the Quick 
Start Guide for LAN Management Solution 2.5 on Cisco.com at 
http://www.cisco.com/univercd/cc/td/doc/product/rtrmgmt/cw2000/cw2000_b/l
ms/lms25/index.htm.

Note If an existing NMS uses port 162, for more information, see Configuring SNMP 
Trap Receiving and Forwarding, page 4-12.

DFM uses the following TCP and UDP ports.

Table 2-1 DFM Ports and Protocols

Protocol Port Number Service Name

Direction (of 
establishment) of 
Connection 

ICMP — Ping Server to Device

UDP 161 Simple Network Management 
Protocol (SNMP)

Server to Device,
Device to Server

162 SNMP Traps (Standard 
Port)—Default port number 
used by DFM for receiving 
traps

Server to Device,
Device to Server

9000 Used for trap receiving (if port 
162 is occupied)

Client to Server
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Gathering Information to Provide During Installation
You might need to supply the following information while you are installing 
DFM: 

• DFM database password and a DFM username and password for use by DFM 
processes—Only required when you perform a custom installation; 
otherwise, this information is randomly generated. 

For more information on creating passwords see the appendix “Password 
Information” in Installation and Setup Guide for Common Services on 
Windows. 

• License information—If you must supply license information, the installation 
script prompts you to enter one of the following:

– Information that you will find printed on the software claim 
certificate—Product Identification Number (PIN) and Product 
Authorization Key (PAK).

TCP 49 TACACS+ and ACS Server to ACS

9002 DynamID authentication 
(Used by DFM broker)

Client to Server

15000 Used by log server Server internal

43445 Used by Fault History 
database engine (dfmFH)

Server internal

43446 Used by inventory service 
database engine (DFMInv)

Server internal

43447 Used by event processing 
database engine (dfmEPM)

Server internal

43500-43520 Used by Common Services 
Transport Mechanism (CSTM) 
for internal DFM 
communication

Server internal

Table 2-1 DFM Ports and Protocols (continued)

Protocol Port Number Service Name

Direction (of 
establishment) of 
Connection 
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– Location of the license file—If you have already obtained a license file, 
provide the path. If not, be sure to obtain one. You can do so before or 
after you install DFM; see Registering Your License, page A-3.

Note You can determine the status of your license from the CiscoWorks 
home page, by selecting Common Services > Server > 
Admin > Licensing.

Note If you are installing DFM for evaluation purposes:

• You do not need to supply a license file or a PIN and a PAK.

• You might be interested in the following information:

– Upgrading Your Evaluation License, page A-3

– Licensing Reminders, page A-4

Performing a New Installation
Use these steps to perform a fresh installation of DFM. 

Note If you are upgrading from DFM 1.2 and using these steps to install DFM 2.0 on a 
fresh system, afterward:

• If you purchased an upgrade license of DFM 2.0, you must run a CLI script 
to validate the upgrade license. (You will be prompted to do so.) 

• You must export data from DFM 1.2 and import it into DFM 2.0. 

For more information, see Chapter 3, “Upgrading DFM.”
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Step 1 Make sure your system meets these prerequisites:

• Required (or desired) operating system upgrades have been performed, and 
required service packs are installed.

• Common Services 3.0 has been installed. (See Installation and Setup Guide 
for CiscoWorks Common Services 3.0 (Includes CiscoView) on Windows.)

• If you want a locally installed NMS to send traps to DFM, HP OpenView or 
NetView has been installed. See Supported NMS Integration, page 1-13.

• If HP OpenView is installed and operational, you have stopped all 
HP OpenView services (if not, the installation will take significantly longer).

Step 2 Close all open or active programs. Do not run other programs during the 
installation process.

Step 3 As the local administrator, log in to the machine on which you will install the 
DFM software, and insert the DFM CD-ROM into the CD-ROM drive. The 
installer window appears, asking you if you want to install DFM.

Note If the CD-ROM is already in the CD-ROM drive and you stopped the 
installation process to close programs or if Autostart is disabled, click 
Setup.exe to restart the process.

The Welcome window appears. 

Step 4 If you are using ACS mode, you will be warned that if you configured any custom 
ACS roles, they will be lost unless you exit the installation and change the AAA 
security mode to CiscoWorks Local. Do one of the following: 

• If you want to continue the installation (you will lose any ACS custom roles), 
click Yes and proceed to Step 5.

• If you do not want to continue the installation (so you can change your AAA 
security mode to CiscoWorks Local and save any ACS custom roles), do the 
following:

– Click No. (You will need to reset your mode to ACS after you have 
installed DFM, as described in Step 15.) The installation will abort.

– From the command prompt, run the following command:

NMSROOT/bin/perl NMSROOT/bin/ResetLoginModule.pl

– Return to Step 3 to begin the installation process again.
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Step 5 In the Software License Agreement dialog box, click Yes to accept the license.

Step 6 If the Licensing Information dialog box appears, select a radio button and enter 
any required information.

Note For instructions on obtaining a license file or locating the PIN and PAK, 
see Preparing to Install DFM, page 2-1.

Step 7 Click Next. The Setup Type dialog box appears. 

Step 8 Select Typical to install the complete DFM package, which contains DFM, the 
DFM IDU base package, and the HPOV-NetView adapters. 

Note The HPOV-NetView adapters are installed whether or not HP Openview 
or NetView is installed.

Note If you choose the Typical installation mode, DFM passwords (for user and 
database) will be randomly generated for you; you can view the 
passwords at the end of the installation. If you choose the Custom 
installation mode, you will be prompted to enter DFM passwords for user 
and database.

Step 9 Click Next. The installation program checks dependencies and system 
requirements.

Step 10 The System Requirements dialog box displays the results of the requirements 
check and advises whether the installation can continue. One of the following 
might occur:

• If there is not enough disk space for the installation, the installation program 
displays an error message and stops.

Note Do not be alarmed if you see the following message:
INFO: total size (MB) required = 87

This message applies to disk space required by the current set of 
individual packages being installed.
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• If the minimum recommended requirements are not met, the installation 
program displays an error message and continues installing.

• If DFM detects another application using port 162, DFM displays the 
following message:

WARNING: Installation has detected port 162 in use. DFM is set to 
use port 9000 for receiving SNMP traps.

If you see this message, after the installation completes, you must configure 
DFM to receive SNMP traps on a different UDP port, such as port 9000. (See 
Configuring SNMP Trap Receiving and Forwarding, page 4-12.)

Step 11 The Select Components dialog box appears with the Install Device Fault 
Manager 2.0 radio button selected. Click Next.

Step 12 The Summary dialog box appears, displaying the current settings. Click Next.

The installation proceeds without displaying any more questions, and the system 
prompt appears. The installation program copies the files to the CiscoWorks 
default installation directory NMSROOT. 

Step 13 If you purchased an upgrade license of DFM 2.0, an information dialog box 
appears with the following message:

Please run the program C:\PROGRA~1\CSCOpx\bin\dfmValidateUpgrade.bat 
to validate that this is an upgrade.

If you see this message, you must run this program after the installation 
completes. (See Validating the Upgrade, page 3-11.) Click OK. 

Step 14 Eject the CD-ROM.

Note Store the CD-ROM in a secure, climate-controlled area for safekeeping.

Step 15 If you exited the installation in order to change your AAA security mode from 
ACS to CiscoWorks Local (in Step 4), reset your security role back to ACS. From 
the Common Services home page, select Server > Security > AAA Mode Setup, 
click Help, and follow the instructions.
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Step 16 Specify the clients that are allowed to connect to the DFM server. (DFM provides 
this fine-grain control as an additional security feature.)

a. Unregister the daemons with the daemon manager:

• For DfmServer:

# NMSROOT\bin\pdcmd -u DfmServer

• For DfmBroker:

# NMSROOT\bin\pdcmd -u DfmBroker

b. Decide which hosts you want to specify, using the --accept option with 
arguments shown in Table 2-2.

For example, this command fragment would allow connections only from 
hosts lucy and ethel:

--accept=lucy,ethel

Table 2-2 Arguments to the --accept Option

Argument Description

host1,host2,... Allow only host1,host2,... to connect to the server. If the 
hostname is registered with DNS, you can specify the client 
by hostname. Otherwise, specify explicit IP addresses in a 
comma-separated list. Hostnames are resolved to one or more 
IP addresses, which are then used (the server does not use 
reverse lookups to determine the name of a connecting host).

Note If you specify the clients as hostnames, be sure the 
hostnames are registered with DNS, especially if you 
are using DHCP.

=any Allow all incoming connections (default).
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Note To allow connections from processes running on the same host, 
specify the host's name—do not use “localhost.” This is because 
connections made using the DFM Broker will appear to come from 
the DFM Broker’s host. Only connections that explicitly specify 
“localhost” as the target address will appear to come from localhost. 
Such target addresses might result in configurations that forward 
incoming connections (such as through software that provides an 
encrypted tunnel).

c. Re-register the daemons with the daemon manager, specifying the clients that 
can connect to the broker and server (in this example, the DFM broker port is 
9002, and lucy and ethel are the clients):

• For DfmBroker (the following command is one line):

# NMSROOT\bin\pdcmd -r DfmBroker -e NMSROOT\objects\smarts\bin\brstart -f "--output 
--port=9002 --accept=lucy,ethel --restore=NMSROOT\objects\smarts\conf\broker.rps"

• For DFMServer (the following command is one line):

# NMSROOT\bin\pdcmd -r DfmServer -e NMSROOT\objects\smarts\bin\sm_server -d DfmBroker -f 
"--bootstrap=DFM_bootstrap.conf --accept=lucy,ethel --output --name=DFM"

d. Make sure that the client names and current IP addresses are registered with 
DNS if one or both of the following apply:

• You are running DHCP 

• You specified the clients with hostnames

Step 17 To verify that the DfmServer process is running, log in to the CiscoWorks home 
page as the administrator and select Common Services > Server > 
Admin > Processes.

Step 18 If you plan to use the HPOV-NetView adapters with Device Fault Manager 2.0, 
make sure the machine running DFM is registered with DNS.

Step 19 To use DFM, select Device Fault Manager from the CiscoWorks home page. A 
Device Fault Manager window opens. 
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If you had any errors during installation, check the installation log in the root 
directory on the drive. (For example, the CiscoWorks CD One installation might 
create C:\Ciscoworks_setup001.log, the DFM installation might create 
C:\Ciscoworks_setup002.log, and so forth.) The Cisco Technical Assistance 
Center (TAC) might ask you to send them the installation log.

If the standard UDP trap port (162) is being used by another NMS, you must 
configure DFM SNMP trap receiving to use a different UDP port, such as port 
9000. See Configuring SNMP Trap Receiving and Forwarding, page 4-12.

If you install HP OpenView or NetView later, you will have to either configure 
DFM SNMP trap receiving to use another port (as described in Configuring 
SNMP Trap Receiving and Forwarding, page 4-12), or reinstall DFM.

To integrate DFM with remote versions of HP OpenView and NetView, you must 
install the HPOV-NetView adapters as described in Installing and Upgrading 
HPOV-NetView Adapters, page 2-13.

Reinstalling DFM
You can use this procedure to reinstall DFM or to reinstall the HPOV-NetView 
adapters. 

Step 1 If HP OpenView is installed and operational, make sure it has been stopped (or 
the installation will take significantly longer).

Step 2 Close all open or active programs. Do not run other programs during the 
reinstallation process.

Step 3 As the local administrator, log in to the machine on which you will install the 
DFM software, and insert the DFM CD-ROM into the CD-ROM drive. The 
installer window appears, asking you if you want to reinstall DFM.

Note If the CD-ROM is already in the CD-ROM drive and you stopped the 
reinstallation process to close programs or if Autostart is disabled, click 
Setup.exe from the top directory of your CD-ROM to restart the process.

Step 4 Click Install. The Welcome window appears.
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Step 5 If you are using ACS mode, you will be warned that if you configured any custom 
ACS roles, they will be lost unless you exit the installation and change the AAA 
security mode to CiscoWorks Local. Do one of the following: 

• If you want to continue the installation (you will lose any ACS custom roles), 
click Yes and proceed to Step 6.

• If you do not want to continue the installation (so you can change your AAA 
security mode to CiscoWorks Local and save any ACS custom roles), do the 
following:

– Click No. (You will need to reset your mode to ACS after you have 
installed DFM, as described in Step 13.) The installation will abort.

– From the command prompt, run the following command:

NMSROOT/bin/perl NMSROOT/bin/ResetLoginModule.pl

– Return to Step 3 to begin the reinstallation process again.

Step 6 In the Setup Type dialog box, select Custom to select the components to reinstall. 
The Select Components dialog box appears.

The system displays these options (the choices may vary, depending on your 
configuration):

Reinstall Device Fault Manager 2.0
Reinstall HPOV-Netview adapters

Step 7 Select the component you want to reinstall and click Next. The Start Copying 
Files window appears. 

Step 8 Click Next.

Step 9 If you reinstalled only the HPOV-NetView adapters, you are prompted to enter the 
name of the machine running DFM. Enter the name of the host (the default is 
localhost).

Note Make sure the machine running DFM is registered with DNS.

Step 10 Click Next.

Step 11 The System Requirements dialog box displays the results of the requirements 
check and advises whether the reinstallation can continue. One of the following 
might occur:
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• If minimum requirements are met, click OK. The Setup screen appears, 
displaying reinstallation progress while files are copied. The Setup Complete 
dialog box appears.

• If recommended requirements are not met, an error message appears. To 
continue the reinstallation, click OK.

If DFM detects another application using port 162, DFM displays the following 
message:

WARNING: Installation has detected port 162 in use. DFM is set to use 
port 9000 for receiving SNMP traps.

If you see this message, after the installation completes, you must configure DFM 
SNMP trap receiving to use a different UDP port, such as port 9000. (See 
Configuring SNMP Trap Receiving and Forwarding, page 4-12.)

Step 12 Remove the DFM CD-ROM from the drive.

Note Store the CD-ROM in a secure, climate-controlled area for safekeeping.

Step 13 If you exited the installation in order to change your AAA security mode from 
ACS to CiscoWorks Local (in Step 5), reset your security role back to ACS. From 
the Common Services home page, select Server > Security > AAA Mode Setup, 
click Help, and follow the instructions.

Step 14 Reboot the machine.

Step 15 To verify that the DfmServer process is running, log in to the CiscoWorks home 
page as the administrator and select Common Services > Server > 
Admin > Processes. 

Step 16 To use DFM, select Device Fault Manager from the CiscoWorks navigation tree.

If you had any errors during reinstallation, check the installation log in the root 
directory on the drive. (For example, the CiscoWorks CD One installation might 
create C:\Ciscoworks_setup001.log, the DFM installation might create 
C:\Ciscoworks_setup002.log, and so forth.) The Cisco Technical Assistance 
Center (TAC) might ask you to send them the installation log.
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Uninstalling DFM

Caution You must use the CiscoWorks uninstallation program to remove DFM from your 
system. If you try to remove the files and programs manually, you can seriously 
damage your system.

Step 1 As the local administrator, log in to the system on which DFM is installed, and 
select Start > Programs > CiscoWorks > Uninstall CiscoWorks to start the 
uninstallation process. 

A dialog box appears, listing the components selected for uninstallation.

Step 2 Click Next.

Messages showing the progress of the uninstallation appear. 

The following message appears:

Uninstallation is complete. Click OK to finish.

Step 3 Click OK.

Installing and Upgrading HPOV-NetView Adapters
When you install DFM on a system with HP OpenView or NetView, the DFM 
installation script installs the HPOV-NetView adapters. These adapters take the 
traps that managed devices send to HP OpenView (or Netview) and forward them 
to DFM. For information on supported HP OpenView and NetView versions, see 
Supported NMS Integration, page 1-13.

This section explains how to install or upgrade the HPOV-NetView adapters on a 
remote host so the adapters can exchange information with DFM on a local host. 
You can install or upgrade the HPOV-NetView adapters on remote hosts 
regardless of whether CiscoWorks is present. You can also use these procedures 
to reinstall the HPOV-NetView adapters.

If you upgrade a local version of DFM, you must also upgrade any remote 
adapters.
2-13
Installation and Setup Guide for Device Fault Manager on Windows

78-16267-01



 

Chapter 2      Installing and Uninstalling DFM
  Installing and Upgrading HPOV-NetView Adapters
Note To upgrade remote HPOV-NetView adapters, you must first remove the old 
adapters and then install the new version.

Note If you move DFM to a different machine, or you want to use a different instance 
of DFM, you must reinstall the HPOV-NetView adapters.

Reinstalling the HPOV-NetView Adapters on a Local Host
If you install NetView or HP OpenView on the local host after you have installed 
DFM, you should reinstall the HPOV-NetView adapters to configure them 
appropriately. See Reinstalling DFM, page 2-10.

Installing or Upgrading the HPOV-NetView Adapter on a Remote 
Host Running CiscoWorks

Step 1 To upgrade a previous version of the HPOV-NetView adapters, remove the 
adapters as described in Removing the HPOV-NetView Adapters from a Remote 
Host Running CiscoWorks, page 2-17.

Step 2 As the local administrator, log in to the machine on which you will install the 
HPOV-NetView adapters, and insert the DFM CD-ROM into the CD-ROM drive. 
The installer window appears, asking you if you want to install DFM.

Note If the CD-ROM is already in the CD-ROM drive and you stopped the 
installation process to close programs or if Autostart is disabled, click 
Setup.exe to restart the process.

The Welcome window appears.

Step 3 Click Next. The Setup Type dialog box appears.

Step 4 Select Custom to select a component to install and click Next. The Select 
Components dialog box appears.
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Step 5 Select Device Fault Manager HPOV-NetView adapters and click Next. 

Step 6 When prompted, enter the machine name or IP address of the machine on which 
DFM is running. 

Note Do not use the default, localhost. Also, make sure the machine running 
DFM is registered with DNS.

Step 7 Click Next. HP OpenView and NetView are stopped. The System Requirements 
dialog box displays the results of the requirements check and advises whether 
installation can continue. 

Step 8 Click OK. The installation program copies the files to the directory in which 
Common Services was installed.

Step 9 Remove the DFM CD-ROM from the drive.

Step 10 Click OK to reboot the machine.

Step 11 Restart HP OpenView or NetView to activate the adapters (using the ovstart or 
nvstart command).

If you had any errors during installation (or upgrade), check the installation log in 
the root directory on the drive. (For example, the Common Services installation 
might create C:\Ciscoworks_setup001.log, the DFM installation might create 
C:\Ciscoworks_setup002.log, and so forth.) The Cisco Technical Assistance 
Center (TAC) might ask you to send them the installation log.

Installing or Upgrading the HPOV-NetView Adapters on a Remote 
Host Not Running CiscoWorks

Caution Do not use this script if DFM is installed. If you use the script on a machine 
containing DFM, you will corrupt the DFM configuration.

Note The DFMadapter.exe script does not support reinstallation.
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Step 1 Verify that you have 31 MB of space for installing the adapters.

Step 2 To upgrade the HPOV-NetView adapters from a previous version, remove the 
adapters as described in Removing the HPOV-NetView Adapters from a Remote 
Host Not Running CiscoWorks, page 2-18.

Step 3 From a temporary directory, use ftp to copy the binary file 
NMSROOT\htdocs\rdist\dfm\DFMadapter.exe from the running DFM. In the 
following commands, dfm-host is where DFM 2.0 is installed, and NMSROOT is 
the DFM installation directory (normally C:\Program Files\CSCOpx):

# cd \Temp
# ftp dfm-host
User (dfm-host:(none)): login
Password: password
ftp> cd NMSROOT\htdocs\rdist\dfm
ftp> get DFMadapter.exe
ftp> quit

Step 4 Double-click DFMadapter.exe. The Choose Destination Location window 
appears.

Step 5 In the Select Destination Folder field, select C:\DFM and click Next. The Setup 
Window appears.

Step 6 Enter the machine name or IP address of the machine on which DFM is running. 

Note Do not use the default, localhost. Also, make sure the machine running 
DFM is registered with DNS.

Step 7 The Setup window appears. In the username field, enter the DFM username. In 
the password field, enter the DFM password. 

Note You can change your username and password. See User Guide for Device 
Fault Manager, available from the online help, for more information.

Step 8 Click Next. The adapters are installed and HP OpenView and NetView are 
stopped.

Step 9 Click Finish. The Restarting Windows dialog box appears.
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Step 10 Select Yes to confirm that you want to reboot, and click OK.

Step 11 Restart HP OpenView or NetView to activate the adapters (using the ovstart or 
nvstart command).

DFM automatically configures the remote adapters to foward SNMP traps from 
HP OpenView and NetView to DFM.

Removing the HPOV-Netview Adapters
When you remove a local version of DFM, the HPOV-Netview adapters are also 
removed. To remove remote adapters, follow the instructions in this section.

Removing the HPOV-NetView Adapters from a Remote Host
You can remove the HPOV-NetView adapters from remote host machines with or 
without installed CiscoWorks products.

Caution You must use the following uninstallation programs to remove the adapters from 
your system. If you try to remove the files and programs manually, you can 
seriously damage your system.

Removing the HPOV-NetView Adapters from a Remote Host Running CiscoWorks

You can remove the HPOV-NetView adapters from remote host machines with or 
without installed CiscoWorks products.

Caution You must use the CiscoWorks uninstallation program to remove the adapters from 
your system. If you try to remove the files and programs manually, you can 
seriously damage your system.
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Step 1 As the local administrator, log in to the system on which the remote 
HPOV-NetView adapters are installed, and select Start > Programs > 
CiscoWorks > Uninstall CiscoWorks to start the uninstallation process. The 
Uninstall window appears, displaying a list of the installed applications.

Step 2 Deselect everything except Device Fault Manager HPOV-NetView adapters.

Step 3 Click Next. A dialog box listing the components selected for removal appears.

Step 4 Click Next to begin removing the HPOV-NetView adapters. Messages showing 
the progress of the uninstallation appear, and the uninstallation completes.

Step 5 Click OK.

If you had any errors during uninstallation, check the installation log in the root 
directory on the drive. (For example, the CiscoWorks CD One installation might 
create C:\Ciscoworks_setup001.log, the DFM installation might create 
C:\Ciscoworks_setup002.log, and so forth.) The Cisco Technical Assistance 
Center (TAC) might ask you to send them the installation log.

Removing the HPOV-NetView Adapters from a Remote Host Not Running 
CiscoWorks

Note If you try to run DFMadapter.exe on a host that is running CiscoWorks or DFM, 
you will receive an error message and the uninstallation will abort.

Step 1 From a temporary directory, use ftp to copy the 
NMSROOT\htdocs\rdist\dfm\DFMadapter.exe binary file from the running DFM. 
In the following commands, dfm-host is where DFM 2.0 is installed, and 
NMSROOT is the DFM installation directory (normally
C:\Program Files\CSCOpx):

# cd \Temp
# ftp dfm-host
User (dfm-host:(none)):login
Password: password
ftp> cd NMSROOT\htdocs\rdist\dfm
ftp> get DFMadapter.exe
ftp> quit
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Step 2 Double-click DFMadapter.exe. The Confirm File Deletion window appears.

Step 3 Click OK. The adapters are removed, and HP OpenView and NetView are stopped 
and restarted. The Setup window appears.

Step 4 Click Finish.
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C H A P T E R 3

Upgrading DFM

This chapter describes upgrading Device Fault Manager (DFM) on a Windows 
system. It includes:

• Upgrade Overview, page 3-1

• Preparing to Upgrade DFM, page 3-6

• Upgrading to DFM 2.0, page 3-7

• Post-Upgrade Steps, page 3-13

Upgrade Overview
DFM 2.0 provides a completely new user interface and many new functions. For 
more information, see Appendix B, “How is DFM 2.0 Different from 
DFM 1.2.x?”

You can perform a local in-place upgrade or a remote upgrade from the following: 

• DFM 1.2 (with or without patch/IDUs).

• DFM 1.2 Updated for Common Services Version 2.2 (with or without 
patch/IDUs).

This document refers to these previous versions as DFM 1.2.x. This section 
provides a brief outline of the procedures and the data migration for each type of 
upgrade. 
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Local Upgrade 
You perform a local in-place upgrade on the system where DFM 1.2.x is installed. 

Procedure for Local Upgrade

Data that Is Migrated by a Local Upgrade

The following data is migrated from DFM 1.2.x to DFM 2.0 when you perform a 
local upgrade:

• Device list—The migration procedure adds devices to Common Services 
Device and Credentials Repository (DCR) and to DFM. 

• Device managed state (managed or unmanaged).

• The following notification information:

– Mail recipient information 

– Mail sender ID

– SMTP addresses 

– Trap destination addresses 

– Trap destination ports

• Some polling and threshold settings—See Upgrading Polling Settings, 
page 3-3 and Upgrading Threshold Settings, page 3-4.

No other data is migrated.

Table 3-1 Local Upgrade Procedure

Tasks Reference

Step 1 Upgrade from DFM 1.2.x to DFM 2.0.

Note To perform the upgrade, you will install DFM 
2.0 from the CD and then manually run a 
program to upgrade your data.

Performing a Local Upgrade, 
page 3-7

Step 2 Perform post-upgrade steps to complete basic 
configuration of DFM 2.0. 

Post-Upgrade Steps, page 3-13
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Upgrading Polling Settings 

Table 3-2 lists DFM 1.2 polling groups and settings and those in DFM 2.0 that 
correspond to them. For a device to retain polling settings from DFM 1.2, a 
corresponding polling group (and settings) must exist in DFM 2.0 and the device 
must belong to it. 

In DFM 2.0, there are several additional polling groups not listed in Table 3-2 (for 
more information, see User Guide for Device Fault Manager). A device might 
belong to a new polling group in DFM 2.0. For example, a voice gateway is a 
member of the Routers polling group in DFM 1.2 and the Voice and Telephony 
polling group in DFM 2.0. 

After upgrade, DFM 2.0 applies factory default settings to:

• Any device that belongs to a different polling group than it did in DFM 1.2.

• Any setting that was removed from a polling group in DFM 1.2. 

The device support table lists the DFM 1.2 and DFM 2.0 groups; refer to Product 
Documentation, page xii.

Table 3-2 Comparison of Polling Groups and Settings between DFM 1.2 and DFM 2.0

Polling Groups Polling Settings

Devices that 
were members of 
these groups in 
DFM 1.2…

And become 
members of these 
groups in 
DFM 2.0…

Retain the values from these 
DFM 1.2 polling settings…1

1. For any polling setting that was removed from a polling group in DFM 1.2, DFM 2.0 sets its value to the DFM 2.0 factory 
default value.

Reflected in these DFM 2.0 
polling settings

Optical Switches Optical Networking • Connectivity Polling

• Environment Polling

• Performance Polling - 
Processor and Memory

• Performance Polling - 
Ports and Interfaces 
(includes access port)

• Reachability settings

• Environment

• Processor and memory 
utilization

• Connector port and 
interface

• Access port 

Switches Switches and Hubs

Routers Routers

Other Systems Voice and 
Telephony 

Connectivity Polling Reachability settings
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Upgrading Threshold Settings 

Like polling settings, threshold settings are retained when a device (or device 
component) is a member of a DFM 2.0 threshold group that corresponds to the 
DFM 1.2 threshold group it was a member of. Table 3-3 lists the corresponding 
threshold groups and settings. 

There are additional threshold groups in DFM 2.0 not listed in Table 3-3 (for more 
information, see User Guide for Device Fault Manager). DFM 2.0 applies factory 
default threshold values to devices that are members of new DFM 2.0 threshold 
groups. The device support table lists the DFM 1.2 and DFM 2.0 groups; refer to 
Product Documentation, page xii.

Table 3-3 Comparison of Threshold Groups and Settings between DFM 1.2 and DFM 2.0

Threshold Groups Threshold Settings/Categories

Devices that were 
members of these in 
DFM 1.2…

And become members 
of these groups in 
DFM 2.0…1

1. Each DFM 2.0 threshold group contains subgroups. This allows you to set threshold settings appropriately for each group of 
devices. 

Retain the values from 
these DFM 1.2 threshold 
settings…2

2. For any threshold setting that was removed from a threshold group in DFM 1.2, DFM 2.0 sets its value to the DFM 2.0 factory 
default value.

Reflected in these 
DFM 2.0 threshold 
categories

Interface Groups Interface Groups For Interface Groups, Access Port Groups, and 
Trunk Port Groups, the threshold settings in 
DFM 1.2 correspond closely to the threshold 
categories in DFM 2.0. For a list of threshold 
categories for these groups, see User Guide for 
Device Fault Manager.

Access Ports Groups Access Port Groups

Trunk Ports Groups Trunk Port Groups

Optical Switches Optical Networking • Connectivity

• Environment

• Processor and Memory 

• Reachability

• Environment

• Processor and 
Memory

Routers Routers

Switches Switches and Hubs
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Remote Upgrade
You perform a remote upgrade on a system where DFM 1.2.x is not installed.

Procedure for Remote Upgrade

Data that Is Migrated by a Remote Upgrade

Only the device list is migrated. However, you can use a DFM 2.0 Upgrade Kit to 
migrate the following additional DFM 1.2.x information:

• Device managed state (managed or unmanaged).

• Some polling and threshold settings (as described in Data that Is Migrated by 
a Local Upgrade, page 3-2).

To use the Upgrade Kit, you must have a copy of the DFM 1.2.x DFM.rps 
(inventory) file. The Upgrade Kit and accompanying Readmes are available from 
the DFM download page at 
http://www.cisco.com/cgi-bin/tablebuild.pl/cw2000-dfm

Table 3-4 Remote Upgrade Procedure

Tasks Reference

Step 1 Upgrade or install DFM 2.0 on the remote 
system.

• Performing a Local Upgrade, page 3-7

• Performing a New Installation, page 2-4

Step 2 If you purchased a DFM 2.0 upgrade license, 
validate the upgrade by providing proof of 
purchase of DFM 1.2.x. 

Validating the Upgrade, page 3-11

Step 3 Export the DFM 1.2.x seed file and import it 
to DFM 2.0; or

Use the DFM 2.0 Upgrade Kit to perform 
your data migration.

Exporting DFM 1.2.x Information to an 
Upgraded Remote Host, page 3-12

Data that Is Migrated by a Remote Upgrade, 
page 3-5

Step 4 Perform post-upgrade steps to complete basic 
configuration of DFM 2.0. 

Post-Upgrade Steps, page 3-13
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Preparing to Upgrade DFM
Before you upgrade, determine whether you need to gather additional information 
and media.

If you purchased an upgrade license of DFM 2.0, you are required to validate the 
upgrade by providing one of the following:

• The original CD containing DFM 1.2 or DFM 1.2 Updated for Common 
Services Version 2.2.

• Login information for a remote server where the previous version of DFM 
(DFM 1.2.x) is running.

Caution If validation is not successful, DFM is installed with an evaluation license; access 
to DFM functionality will be prohibited when the license expires. 

You might need to provide the following information during the upgrade: 

• DFM database password and a DFM username and password for use by DFM 
processes—Only required when you perform a custom installation; 
otherwise, this information is randomly generated. 

For more information on creating passwords, see the appendix “Password 
Information” in Installation and Setup Guide for Common Services on 
Windows. 

• License information—If you must supply license information, the installation 
script prompts you to enter one of the following:

– Information that you will find printed on the software claim 
certificate—Product Identification Number (PIN) and Product 
Authorization Key (PAK).

– Location of the license file—If you have a license file, provide its 
location. If not, be sure to obtain one. You can do so before or after you 
install DFM; see Registering Your License, page A-3.

Note You can determine the status of your license from the CiscoWorks 
home page, by selecting Common Services > Server > 
Admin > Licensing.
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Note If you are installing DFM for evaluation purposes:

• You do not need to supply a license file or PIN and PAK.

• You might be interested in the following information:

– Upgrading Your Evaluation License, page A-3

– Licensing Reminders, page A-4

Upgrading to DFM 2.0
You can upgrade from DFM 1.2.x, with or without patch/IDUs, to DFM 2.0 on 
local or remote systems. If desired, you can upgrade a remote system and then 
export your local DFM 1.2.x information to the upgraded remote system. These 
procedures are described in the following sections:

• Performing a Local Upgrade, page 3-7

• Performing a Remote Upgrade, page 3-11

Performing a Local Upgrade
Follow these steps to upgrade a local host to DFM 2.0.

Step 1 Make sure your system meets the following prerequisites:

• Required (or desired) operating system upgrades have been performed, and 
required service packs are installed.

• All installed applications are supported by Common Services 3.0. 
Applications not supported by Common Services 3.0 will be disabled when 
you upgrade CD One. 

• Common Services 3.0 has been installed. (See Installation and Setup Guide 
for Common Services (Includes CiscoView) on Windows.)

• If you want a locally installed NMS to send traps to DFM, HP OpenView or 
NetView has been installed. See Supported NMS Integration, page 1-13.
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Step 2 As the local administrator, log on to the system on which you will install the DFM 
software, and insert the DFM CD-ROM into the CD-ROM drive. The installer 
window appears, asking you if you want to install DFM.

Note If the CD-ROM is already in the CD-ROM drive and you stopped the 
installation process to close programs or if Autostart is disabled, click 
Setup.exe to restart the process.

The Welcome window appears. 

Step 3 Click Next. The Software License Agreement dialog box appears.

The installation program stops CiscoWorks, performs a requirements check, and 
might display a request to enter license information; for more information, see 
Appendix A, “Licensing.”

Step 4 If you are using ACS mode, you will be warned that if you configured any custom 
ACS roles, they will be lost unless you exit the upgrade and change the AAA 
security mode to CiscoWorks Local. Do one of the following: 

• If you want to continue the upgrade (you will lose any ACS custom roles), 
click Yes and proceed to Step 5.

• If you do not want to continue the upgrade (so you can change your AAA 
security mode to CiscoWorks Local and save any ACS custom roles), do the 
following:

– Click No. (You will need to reset your mode to ACS after you have 
installed DFM, as described in Step 13.) The installation will abort.

– From the command prompt, run the following command:

NMSROOT/bin/perl NMSROOT/bin/ResetLoginModule.pl

– Return to Step 2 to begin the upgrade process again.

Step 5 In the Setup Type dialog box, select Typical to install the complete DFM package, 
which contains DFM and the HPOV-NetView adapters. (For more information on 
installation components, refer to Table 1-1 on page 1-2.)

Note The HPOV-NetView adapters are installed whether or not HP Openview 
or NetView is installed. 
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Step 6 Click Next. The installation program checks dependencies and system 
requirements.

Step 7 The System Requirements dialog box displays the results of the requirements 
check and advises whether the installation can continue. One of the following 
should then occur:

The installation program checks dependencies and system requirements:

• If there is not enough disk space for the installation, the installation program 
displays an error message and stops.

Note Do not be alarmed if you see the following message:
INFO: total size (MB) required = 87

This message applies to disk space required by the current set of 
individual packages being installed.

• If the minimum recommended requirements are not met, the installation 
program displays an error message and continues installing.

If DFM detects another application using port 162, DFM displays the following 
message:

WARNING: Installation has detected port 162 in use. DFM is set to use 
port 9000 for receiving SNMP traps.

If you see this message, after the installation completes, you must configure DFM 
to receive SNMP traps on a different UDP port, such as port 9000. (See 
Configuring SNMP Trap Receiving and Forwarding, page 4-12.)

Step 8 The Select Components dialog box appears with the Install Device Fault 
Manager 2.0 radio button selected. Click Next.

Step 9 The Summary dialog box appears, displaying the current settings. Click Next. 

Step 10 The upgrade program performs the following actions: 

• Copies the files to the CiscoWorks default installation directory NMSROOT. 

• Exports data (see Data that Is Migrated by a Local Upgrade, page 3-2). 

Step 11 Click OK. The system prompt appears.
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Step 12 Unmount and eject the CD-ROM.

Note Store the CD-ROM in a secure, climate-controlled area for safekeeping.

Step 13 If you exited the upgrade in order to change your AAA security mode from ACS 
to CiscoWorks Local (in Step 4), reset your security role back to ACS. From the 
Common Services home page, select Server > Security > AAA Mode Setup, 
click Help, and follow the instructions.

Step 14 If you are performing a remote upgrade and want to use the DFM 2.0 Upgrade Kit 
(to migrate the additional information described in Data that Is Migrated by a 
Remote Upgrade, page 3-5), download the Upgrade Kit and follow the 
instructions in the accompany Readmes. The Upgrade Kit is available from 
Cisco.com at: http://www.cisco.com/cgi-bin/tablebuild.pl/cw2000-dfm.

If you are performing a remote upgrade and do not want use the DFM 2.0 Upgrade 
Kit (to migrate the additional information described in Data that Is Migrated by a 
Remote Upgrade, page 3-5), proceed to Step 15.

Step 15 If you are performing a local upgrade, upgrade DFM 1.2.x data to DFM 2.0 using 
the following command:

NMSROOT\bin perl DFM12x-DFM20-upgrade.pl

where NMSROOT is the default installation directory, normally 
C:\Progra~1\CSCOpx.

The script automatically does all of the following:

1. Imports the seedfile generated from DFM1.2.x into DCR.

2. Imports devices from DCR into DFM 2.0 and monitors device import status. 

Note Device import can take a maximum of 3 hours, depending on the 
number of devices in your inventory.
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3. Applies the manage/unmanage state of the devices/device components 
obtained from DFM1.2.x during the upgrade. 

4. Applies new polling and threshold settings to the devices.

Step 16 To check the status of device discovery and to complete your configuration of 
DFM, see Post-Upgrade Steps, page 3-13.

Performing a Remote Upgrade
Perform these steps after DFM 2.0 is installed on a remote system:

1. If you purchased an upgrade license of DFM 2.0, you must validate the 
upgrade. See Validating the Upgrade, page 3-11.

2. Export DFM 1.2.x information to DFM 2.0. Exporting DFM 1.2.x 
Information to an Upgraded Remote Host, page 3-12

Note Because the standard remote upgrade procedure only migrates the 
DFM 1.2.x device list, a DFM 2.0 Upgrade Kit is available on Cisco.com, 
which migrates the additional information listed in Data that Is Migrated 
by a Remote Upgrade, page 3-5. If you want to use the Upgrade Kit, you 
do not have to perform 2.

Validating the Upgrade 

If you purchased an upgrade license of DFM 2.0, you must validate the upgrade 
on the system where DFM 2.0 is installed using the following command:

NMSROOT\bin\dfmValidateUpgrade.bat 

where NMSROOT is the default installation directory, normally 
C:\Progra~1\CSCOpx. The following prompt is displayed:

This utility will validate your proof of purchase of the product and 
allows you to obtain an upgrade license. 
Please select the source for upgrade validation:
1. Validate from a CD (old version).
2. Validate from a remote server (old version).
Please enter option [1 / 2]: 
3-11
Installation and Setup Guide for Device Fault Manager on Windows

78-16267-01



 

Chapter 3      Upgrading DFM
  Upgrading to DFM 2.0
Enter 1 or 2 and follow the instructions provided by the prompts. For example, if 
you enter 1:

Please insert the previous versions of DFM CD into the CDROM drive and 
provide the absolute path to the CD drive:
D:
Validation succeeded.

For example, if you enter 2:

Please enter the remote CiscoWorks server host name or the IP address: 
dfm-host
Please enter the remote CiscoWorks server http port number: 1741
Please enter the remote CiscoWorks server login name: admin
Please enter the remote CiscoWorks server login password: *******
Please be patient. Upgrade validation is in progress from a remote 
server.
Validation succeeded.

Note If validation does not succeed, you can continue with the upgrade, however:

• DFM is licensed for evaluation only and operates in nag mode for no more 
than 90 days before ceasing operation. (See Evaluation Version: Before 
Expiry, page A-5.) 

• You must contact your Cisco representative to purchase a fully licensed 
version of DFM. (See Upgrading Your Evaluation License, page A-3.) 

Exporting DFM 1.2.x Information to an Upgraded Remote Host

This procedure exports your local DFM 1.2.x device inventory and imports it to a 
remote system that has been upgraded to DFM 2.0.

Note If you are using the DFM 2.0 Upgrade Kit, you do not need to perform this step. 
Refer to Data that Is Migrated by a Remote Upgrade, page 3-5.
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Step 1 Log in to the local DFM 1.2.x system as a local administrator. 

Step 2 Run the following command, where NMSROOT is the default installation 
directory (normally C:\Program Files\CSCOpx):

NMSROOT\objects\smarts\bin\sm_tpmgr.exe -s DFM --dump-agent > 
seedfile.txt 

Step 3 Copy the seedfile.txt that you created in Step 2 to a temporary location on the 
server where DFM 2.0 is installed. 

Step 4 Log in to the remote DFM 2.0 system as a local administrator. 

Step 5 Import devices using the following command, where NMSROOT is the default 
installation directory (normally C:\Program Files\CSCOpx):

NMSROOT\bin\dfmimport fn=<complete directory path\seedfile name>

Note If an error occurs because the CiscoWorks daemon manager is not running, start 
it by typing the following command:

#c: net start crmdmgtd 

Post-Upgrade Steps
After the upgrade script completes, DFM discovers devices and updates its 
managed inventory. DFM might take some time to complete this task. Afterward, 
you should do the following:

• Familiarize yourself with new device management procedures; see 
Performing Device Management, page 4-6.

• Verify discovery status; see Verifying Devices Added to DFM, page 4-7. 

• Complete basic configuration steps; see Configuring SNMP Trap Receiving 
and Forwarding, page 4-12.

• Start using DFM to monitor the network; see Viewing Alerts, page 4-18 and 
What Next?, page 4-19.
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If you plan to use HPOV-NetView adapters on a remote system, with Device Fault 
Manager 2.0 on a local system, perform these steps:

1. Make sure the system running DFM is registered with DNS.

2. Upgrade all remote adapters as described in Installing and Upgrading 
HPOV-NetView Adapters, page 2-13.

Note If the standard UDP trap port (162) is being used by another NMS—such as Cisco 
Voice Manager—you must configure DFM SNMP trap receiving to use a different 
UDP port, such as port 9000. See Configuring SNMP Trap Receiving and 
Forwarding, page 4-12.

If you install another NMS—such as Cisco Voice Manager—after installing 
DFM, you must:

1. Configure DFM to forward traps to the listening port for the NMS. See 
Configuring SNMP Trap Forwarding, page 4-17.

2. Make sure the NMS is configured to receive traps at the port you specified in 
Step 1. Refer to the appropriate documentation for the NMS.

If a local version of HP OpenView or NetView is already installed (or is installed 
later), CiscoWorks automatically configures the adapters to forward SNMP traps 
to DFM. To configure remote versions of HP OpenView and NetView to forward 
SNMP traps to DFM, you must install the HPOV-NetView adapters on the remote 
systems as described in Installing and Upgrading HPOV-NetView Adapters, 
page 2-13.
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Getting Started

This section provides a minimum number of steps for setting up DFM and viewing 
diagnostic results. It is intended to help you to start using DFM immediately.

Configuration Roadmap
Table 4-1 lists the basic tasks for setting up DFM.

Table 4-1 Configuration Roadmap

Task Steps References

Add devices to DFM 
managed inventory.

1. Add devices and credentials 
to Common Services Device 
and Credentials Repository 
(DCR).

• Managing Device Credentials, 
page 4-5

• Importing Devices to the Device 
and Credentials Repository, 
page 4-6

2. Verify that devices were 
discovered (and 
troubleshoot problems, if 
necessary).

• Verifying Devices Added to 
DFM, page 4-7

• Troubleshooting Device 
Discovery, page 4-10
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After you complete the tasks in Table 4-1:

• You can monitor the network using the Alerts and Activities display (see 
Viewing Alerts, page 4-18).

• You can use DFM and continue to configure it; see What Next?, page 4-19.

Configure Trap Receiving 3. Determine which of the 
following approaches to 
SNMP trap receiving to take 
and perform the appropriate 
steps: 

—

• Send SNMP traps directly to 
DFM:

a. Update DFM trap 
receiving port if 
necessary.

b. Enable devices to send 
traps to DFM.

—

• Updating the SNMP Trap 
Receiving Port, page 4-13

• Enabling Devices to Send Traps 
to DFM, page 4-13

• Integrate DFM SNMP trap 
receiving with other NMSs 
or trap daemons.

• Integrating DFM Trap Receiving 
with NMSs or Trap Daemons, 
page 4-15

(Optional) Configure DFM 
Trap Forwarding

4. Configure DFM to forward 
traps.

Configuring SNMP Trap 
Forwarding, page 4-17

Table 4-1 Configuration Roadmap (continued)

Task Steps References
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Using the CiscoWorks Home Page
The CiscoWorks home page is the launch point for CiscoWorks applications and 
the window from which you log out of CiscoWorks applications. The CiscoWorks 
home page includes launch points for:

• Common Services—Services for CiscoWorks applications to perform tasks 
such as configuring the server, selecting a login module, and creating a device 
credentials database.

• Device Center—A center where you can examine and act on a selected 
device; provides a summary and links to tools you can use, reports you can 
run, and tasks you can perform on the device. 

• Locally installed CiscoWorks applications—By default, the locally installed 
Device Fault Manager appears on the CiscoWorks home page. 

If you would like to launch additional applications directly from the CiscoWorks 
home page, you can do so by registering the applications with the local 
CiscoWorks home page.

Note For more information about how DFM integrates with Common Services, Device 
Center, and the CiscoWorks home page, see User Guide for Device Fault 
Manager.

Registering Applications with the CiscoWorks Home Page
Registering applications with the CiscoWorks home page enables you, for 
example, to launch remote CiscoWorks applications from the local CiscoWorks 
home page:

• On a standalone DFM, you can register a remote Resource Manager 
Essentials (RME) to the CiscoWorks home page.

• On a remote RME, you can register a standalone DFM to the CiscoWorks 
home page. (Do this while logged into the local CiscoWorks home page for 
the remote RME.) 

• On a local DFM, if you have an additional DFM server, you can also register 
it to the CiscoWorks home page. 
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Note For a CiscoWorks application to register with the CiscoWorks home page, it must 
run on CiscoWorks Common Services 3.0.

For information about registering a DFM server to the CiscoWorks home page, 
see User Guide for Device Fault Manager. For complete information about 
Common Services, see User Guide for CiscoWorks Common Services.

Understanding and Configuring Security
DFM supports the following security-related mechanisms:

• SNMPv3 protocol (Authentication/No-Privacy option)—DFM supports the 
authentication/no-privacy option between the server and the device.

• Security on the CiscoWorks server—You can configure the following aspects 
of security for the server on which DFM resides:

– Secure Socket Layer (SSL)—DFM can use SSL protocol between the 
server and the browser. You can enable and disable SSL for the server. If 
you enable SSL, you should set up a self-signed security certificate to 
enable SSL communication. For more information, see User Guide for 
Device Fault Manager.

– Local security or Cisco Secure ACS—Access to tasks within DFM is 
controlled either by local security, provided by Common Services, or by 
Cisco Security ACS. Local security is enabled on the server by default. 
DFM supports integration with Cisco Secure ACS. You use Common 
Services to select the type of security you want. 

Note For more information, see User Guide for Device Fault Manager.
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Managing Device Credentials
DCR is a common repository of devices and their credentials for use by individual 
applications. DFM takes its device list and credentials from DCR. DCR enables 
DFM to synchronize with or select from a device list that:

• Is shared by other CiscoWorks applications that are installed locally. This is 
the default.

• Can be shared by remote CiscoWorks applications if the remote CiscoWorks 
server has been configured to use the same master instance of DCR. 

Note To set up DCRs in a configuration with a master and slaves, see User 
Guide for Common Services. See also User Guide for Device Fault 
Manager for details about DFM integration with DCR.

• Can synchronize with network management systems (NMSs) installed locally 
or remotely. 

You will use DCR to: 

• Add a single device or import devices in bulk to the repository.

• Exclude devices from being imported to the repository.

• Delete devices from the repository.

To perform these tasks, see User Guide for CiscoWorks Common Services. For 
scenarios for DFM, see Performing Device Management, page 4-6.
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Performing Device Management
There are two distinct sets of device management tasks:

• Maintaining a device list and credentials—You must use Common Services 
Device and Credentials Repository to perform the associated tasks for all 
CiscoWorks applications. 

• Adding devices to DFM, discovering them, and maintaining a managed 
inventory of devices—You must use DFM to perform these tasks. By default, 
DFM automatically synchronizes its device inventory with the devices in 
DCR. Alternatively, you can configure DFM to manage devices only after you 
select them from DCR. 

Importing Devices to the Device and Credentials Repository
You can import devices to DCR from an NMS or from a file. The file format is 
documented in User Guide for Common Services. 

Note You can import devices from a previous version of DFM by following the 
instructions in Exporting DFM 1.2.x Information to an Upgraded Remote Host, 
page 3-12.

Adding Devices to DFM

Note Devices must exist in DCR before you can add them to DFM.

Step 1 On the DFM home page, select Device Management > Device Selector.

Step 2 To manually select devices to add to DFM:

a. Deselect the Synchronize with Device Credentials Repository check box. (By 
default, the check box is selected.)

b. After new devices have been added to DCR, click Ctrl and select devices 
from the Devices not in Device Fault Manager list.
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c. Click the > Add >> button. 

d. Click OK. 

Step 3 To automatically add devices to DFM:

a. Select the Synchronize with Device Credentials Repository check box.

b. Click OK. 

For more information, see User Guide for Device Fault Manager.

Verifying Devices Added to DFM
You can verify that your devices have been added to DFM by checking the 
following:

• A brief summary—See Viewing the Device Summary, page 4-7.

• Details for devices in a particular device state—See Viewing Device Details, 
page 4-8.

• Discovery status of all devices—See Viewing Discovery Status, page 4-9.

If you find that problems have occurred during device discovery, see 
Troubleshooting Device Discovery, page 4-10.

Viewing the Device Summary

Step 1 On the DFM home page, select Device Management > Device Summary. The 
Device Summary page opens.

The device summary displays the number of devices in each of the following 
device states:

• Known—The device has been successfully imported and is fully managed by 
DFM.

• Learning—DFM is discovering the device. This is the beginning state, when 
the device is first added or is being rediscovered.
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• Questioned—DFM cannot manage the device. See Troubleshooting Device 
Discovery, page 4-10.

• Pending—The device is being deleted. DFM is waiting for confirmation from 
all of its data collectors before purging the device and its details.

• Unknown—DFM does not support the device.

For a list of devices in a particular device state, see Viewing Device Details, 
page 4-8. For a list of all devices, see Viewing Discovery Status, page 4-9.

Viewing Device Details

Step 1 On the DFM home page, select Device Management > Device Details. The 
Device Report page opens. In the Device Selector pane, a device group for each 
current device state is displayed. 

Step 2 Select a device group or devices from a group and click View. The Device Details 
report opens in a new window and displays the following information.

Column Description

Device Name IP address or DNS name for the device.

IP Address IP address for the device.

Status The device state: Known, Learning, Questioned, Pending, 
or Unknown.

For device state definitions, see Viewing the Device 
Summary, page 4-7.

If devices are not in the Known state, see Troubleshooting 
Device Discovery, page 4-10.

Device Type The device type; for example, Content Networking, 
Routers, Switches and Hubs, and so on. For more 
information, see User Guide for Device Fault Manager.

First Added Date and time the device was first added to DFM.

Last Discovered Date and time of most recent discovery.
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Viewing Discovery Status

The discovery status page displays all devices in a tabular format along with their 
processing and discovery state.

Step 1 On the DFM home page, select Device Management > Discovery Status. The 
Discovery Status page opens.

The View Discovery Status table displays the following information:

Step 2 To view the status of device discovery, select Device Fault Manager > Device 
Management > View Discovery Status.

Column Description

Device Name IP address or DNS name for the device.

Status Device state—Known, Learning, Questioned, Pending, or 
Unknown.

For device state definitions, see Viewing the Device 
Summary, page 4-7.

If devices are not in the Known state, see Troubleshooting 
Device Discovery, page 4-10.

DFM Processing Processing status—One of the following:

• Active—DFM is managing the device.

• Suspended—DFM is not managing the device.

• N/A—DFM cannot manage the device; the device state 
is Questioned.

Last Discovered Date and time of most recent discovery.
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Troubleshooting Device Discovery

To troubleshoot device discovery, try the following:

• If a device is not responding, confirm all device credentials and readd the 
device. See Changing Device Credentials, page 4-10.

• Increase SNMP timeout settings if device rediscovery times out for several 
devices. See Modifying SNMP Timeout and Retries, page 4-10.

• View device error information on the Edit Device Configuration page. See 
Rediscovering a Device, page 4-11.

• Verify that the device is operational during the import and that it supports 
MIB II.

• Check the reason for devices in the Questioned state. See Understanding 
Device Discovery Messages, page 4-11.

After troubleshooting your problem, check the device status. See Viewing 
Discovery Status, page 4-11.

Changing Device Credentials

You change device credentials using Common Services DCR. 

Modifying SNMP Timeout and Retries

If an SNMP query does not respond in time, DFM times out. DFM retries 
contacting the device for as many times as you indicate. The timeout period is 
doubled for every subsequent retry. 

For example, if the timeout value is 4 seconds and the retries value is 3 seconds, 
DFM waits 4 seconds before the first retry, 8 seconds before the second retry, and 
16 seconds before the third retry.

The SNMP timeout and retry values are global settings. Change these values as 
follows:

Step 1 Select Device Management > SNMP Config. The SNMP Configuration page 
appears.

Step 2 Select a new SNMP Timeout setting. The default is 4 seconds.
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Step 3 Select a new Number of Retries setting. The default is 3 retries.

Step 4 Click Apply. Click Yes to confirm.

Rediscovering a Device

You can rediscover devices or device groups using the Rediscover/Delete Devices 
page. When rediscovery takes place, any new device configuration settings 
overwrite the previous settings.

Step 1 Select Device Management > Rediscover/Delete. The Rediscover/Delete 
Devices page appears.

Step 2 Select the devices or group(s) you want to rediscover. 

Step 3 Click Rediscover.

Rediscovery is started. To view rediscovery status, select Device Management > 
View Discovery Status.

Viewing Discovery Status

To view the discovery status of a device, select Device Management > View 
Discovery. 

Understanding Device Discovery Messages

Table 4-2 lists messages that might be shown for devices in the Questioned state.
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Configuring SNMP Trap Receiving and Forwarding
DFM can receive traps on any available port and forward them to a list of devices 
and ports. This capability enables DFM to easily work with other trap processing 
applications. However, you must enable SNMP on your devices and configure 
SNMP to send traps either directly to DFM or to one of the following:

• An NMS

• A trap daemon

Table 4-2 Import Error Messages

Message Meaning Action

SNMP Timeout The device is in the Questioned 
state because the SNMP read-only 
community string for the device is 
incorrect.

See Changing Device Credentials, 
page 4-10 to enter the correct read 
community string for the device.

Others: Missing IP Address 
or Data Collector Timeout

The device is in the Questioned 
state because of some other reason. 
It could be that DNS resolution for 
the device failed or the data 
collector timed out.

Click the device on the 
Rediscover/Delete Devices page. 
The error message displays the 
exact problem.

• If the IP address is missing:

– Readd the device with the 
correct IP address.

or

– Make sure that DFM can 
resolve the device name: 
try adding the domain 
name as part of the device 
name.

• If the data collector times out, 
restart the daemon manager to 
get all data collectors in sync.
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To send traps directly to DFM, perform the tasks in Enabling Devices to Send 
Traps to DFM, page 4-13. To integrate SNMP trap receiving with an NMS or a 
trap daemon, follow the instructions in Integrating DFM Trap Receiving with 
NMSs or Trap Daemons, page 4-15.

Updating the SNMP Trap Receiving Port
By default, DFM receives SNMP traps on port 162. If you need to change the port 
(for example, to port 9000), you can do so.

Step 1 On the Configuration tab of the DFM home page, select Other Configurations > 
SNMP Trap Receiving.

Step 2 Enter the port number in the Receiving Port entry box.

Step 3 Click Apply.

For a list of ports that DFM uses, see Verifying TCP and UDP Ports that DFM 
Uses, page 2-2.

Enabling Devices to Send Traps to DFM
Because DFM uses SNMP MIB variables and traps to determine device health, 
you must configure devices to provide this information. For any Cisco devices that 
you want DFM to monitor, SNMP must be enabled and the device must be 
configured to send SNMP traps to the DFM server.

Make sure your devices are enabled to send traps to DFM by using the command 
line or GUI interface appropriate for your device:

• Enabling Cisco IOS-Based Devices to Send Traps to DFM, page 4-14

• Enabling Catalyst Devices to Send SNMP Traps to DFM, page 4-14
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Enabling Cisco IOS-Based Devices to Send Traps to DFM

For devices running Cisco IOS software, provide the following commands:

(config)# snmp-server [community string] ro
(config)# snmp-server enable traps
(config)# snmp-server host [a.b.c.d] traps [community string]

where [community string] indicates an SNMP read-only community string and 
[a.b.c.d] indicates the SNMP trap receiving host (the DFM server).

For more information, see the appropriate command reference guide.

Step 1 Log in to Cisco.com.

Step 2 Select Products & Solutions > Cisco IOS Software.

Step 3 Select the Cisco IOS Software release version used by your Cisco IOS-based 
devices.

Step 4 Select Technical Documentation and select the appropriate command reference 
guide. 

Enabling Catalyst Devices to Send SNMP Traps to DFM

For devices running Catalyst software, provide the following commands:

(enable)# set snmp community read-only [community string]
(enable)# set snmp trap enable all
(enable)# set snmp trap [a.b.c.d] [community string]

Where [community string] indicates an SNMP read-only community string and 
[a.b.c.d] indicates the SNMP trap receiving host (the DFM server).

For more information, see the appropriate command reference guide.

Step 1 Log in to Cisco.com.

Step 2 Select Products & Solutions > Switches.
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Step 3 Select the appropriate Cisco Catalyst series switch.

Step 4 Select Technical Documentation and select the appropriate command reference 
guide. 

Integrating DFM Trap Receiving with NMSs or Trap Daemons
You might need to complete one or more of the following steps to integrate trap 
receiving with other trap daemons:

• Add the host where DFM is running to the list of trap destinations in your 
network devices. See Enabling Devices to Send Traps to DFM, page 4-13. 
Specify port 162 as the destination trap port.

If another NMS is already listening for traps on the standard UDP trap port 
(162), you must configure DFM to use another port, such as port 9000. See 
Updating the SNMP Trap Receiving Port, page 4-13.

• If your network devices are already sending traps to another management 
application, configure that application to forward traps to DFM. See 
appropriate documentation for the management application.

The following sections describe different scenarios for SNMP trap receiving and 
lists the advantages of each.

Scenarios—DFM Receives SNMP Traps and Forwards Them to an NMS

Table 4-3 lists configurations in which DFM receives SNMP traps and forwards 
them to an NMS. 
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Scenarios—An NMS Receives SNMP Traps and Forwards Them to DFM

Table 4-4 lists configurations in which an NMS receives SNMP traps and 
forwards the traps to DFM. In these configurations, the HPOV-NetView adapters 
forward SNMP traps to DFM; the adapters must be installed properly. For more 
information, see Installing and Upgrading HPOV-NetView Adapters, page 2-13.

Table 4-3 Configuring DFM to Receive SNMP Traps and Forward Them

With DFM 
installed 
on…

You can configure DFM to…

Advantages

Receive traps 
on this port 
and…

Forward traps to an 
NMS on this port

A host with 
an NMS

162 (standard 
listening port 
and DFM 
default)

9000 (nonstandard 
listening port)

Note You must 
configure the 
NMS to listen 
on this port.

• DFM provides a reliable trap reception 
and forwarding mechanism.

• Devices do not need to be reconfigured to 
send traps to another host or port.

• DFM and the NMS run on the same host.

9000 162 • DFM provides a reliable trap reception 
and forwarding mechanism.

• No reconfiguration of the NMS is 
required; it continues to listen for traps on 
default port 162.

• DFM and the NMS run on the same host.

A host and an 
NMS 
installed on a 
remote host

162 162 (on the remote 
host)

• DFM provides a reliable trap reception 
and forwarding mechanism.

• NMS continues to receive traps on port 
162.

• Network devices continue to send traps to 
port 162.
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Configuring SNMP Trap Forwarding
By default, DFM does not forward unprocessed SNMP traps. However, you can 
configure it to do so.

Step 1 On the Configuration tab of the DFM home page, select Other Configurations > 
SNMP Trap Forwarding.

Step 2 For each host, enter:

• An IP address or DNS name for the hostname.

• A port number on which the host can receive traps. 

Step 3 Click the Apply button.

Table 4-4 Configuring DFM to Receive SNMP Traps Forwarded by an NMS 

With DFM 
installed on…

And the NMS receiving 
traps on this port …

Configure DFM to 
receive traps 
(forwarded from the 
NMS) on this port… Advantages

A host with an 
NMS

162 (standard listening 
port)

9000 (nonstandard 
listening port)

• No reconfiguration of the 
NMS is required.

• No reconfiguration of network 
devices is required.

• DFM and the NMS run on the 
same host.

• DFM does not receive traps 
dropped by the NMS.

A host and an 
NMS installed 
on a remote host

162 (on the remote host)

Note You must install 
the 
HPOV-NetView 
adapters on the 
remote host.

162 • No reconfiguration of the 
NMS is required.

• No reconfiguration of network 
devices is required.

• DFM does not receive traps 
dropped by the NMS.
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Viewing Alerts
To start the Alerts and Activities display, from the DFM home page, select Alerts 
and Activities.

Starting DFM
To start DFM, log into the CiscoWorks home page. In the Device Fault Manager 
pane, click the Device Management link. A Device Fault Manager window—the 
DFM home page—opens, focused on the Alerts and Activities tab. After you open 
the DFM home page, you can access all DFM applications from it. 

Note Clicking any of the following links on the CiscoWorks home page causes the 
DFM home page to shift focus from the Alerts and Activities tab to the 
correspondingly named tab:

• Device Management

• Notification Services

• Fault History

• Configuration

Clicking the Alerts and Activities link opens a separate Device Fault Manager 
window with an Alerts and Activities display, a real-time monitor for displaying 
the operational health of your network.

Note You must add devices to DFM before the Alerts and Activities display can show 
results.
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What Next?
After you complete the tasks in this chapter, DFM will be ready to monitor and 
analyze events and provide notification of alerts on the Alerts and Activities 
display. 

Table 4-5 summarizes how to continue setting up DFM.

Table 4-5 Setting Up DFM

Task Description

Configure views for the Alerts and 
Activities display

View groups control which groups of 
devices are the focus of the Alerts and 
Activities display. DFM provides two 
default view groups. You can add 
additional view groups.

Configure notifications In addition to learning about alerts by 
monitoring the Alerts and Activities 
display, you can subscribe users to 
receive e-mail and hosts to receive 
DFM-generated SNMP traps in 
response to alerts.

Configure polling parameters and 
thresholds

DFM provides default values for 
polling parameters and threshold 
values. However, you can update the 
values as needed for your network. You 
should plan to apply the changes when 
activity on the DFM server is low.

Configure purging By default, DFM purges the database 
daily at midnight. You can modify the 
schedule.

Configure rediscovery DFM provides a single default 
schedule for rediscovery. You can use 
that schedule, or suspend it and create 
additional rediscovery schedules.
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To use DFM more fully, you might want to perform additional configuration tasks. 
See the online help or User Guide for Device Fault Manager for information on 
using and configuring DFM.
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Licensing

This appendix provides licensing information for DFM. It contains the following 
sections:

• Licensing Overview, page A-1

• Licensing for a Fresh Installation, page A-2

• Upgrading Your Evaluation License, page A-3

• Validating Your Upgrade License, page A-4

• Licensing Reminders, page A-4

Licensing Overview
Installation ensures that you possess a registered and a licensed copy of DFM 2.0. 
The installation script asks the first application installed on Common Services 3.0 
to enter licensing information. The following licensing information is shipped 
with the product, printed on the software claim certificate.
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During the installation, if you are prompted to enter licensing information, you 
can enter either of the following:

• PIN (and PAK)—PIN is mandatory. You are permitted to enter the PAK 
number later, if required. 

• License file location—If you have registered the PAK on Cisco.com and 
received the license file, you can browse to enter its location. 

Note You can obtain a license file before or after you install DFM. (See 
Registering Your License, page A-3.) 

Licensing for a Fresh Installation
The installation script asks the first application installed on Common Services 3.0 
for the PIN, PAK, and license file location details. 

For instance, when DFM 2.0 is installed over Common Services 3.0, the installer 
verifies whether or not the system already has the PIN, PAK, and license file 
details. The details are available if the information was entered earlier using 
another CiscoWorks application.

If the details are not available, then during the DFM 2.0 installation, the installer 
requests the PIN and PAK or the license file location. 

Field Description

Product 
Identification 
Number (PIN)

PIN identifies the type of installation, which may be one 
of the following:

• Evaluation installation—For an evaluation copy, 
licensing details are not required.

• Fresh installation.

• Upgrade installation.

Product 
Authorization Key 
(PAK)

PAK is used to register DFM 2.0 on Cisco.com and 
contains resource limitations. A license file is sent to you 
after you register the PAK on Cisco.com.
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For an evaluation copy of DFM 2.0, licensing details are not required. When 
prompted for licensing information, enter E (for evaluation).

Note A message appears at the end of the installation, urging you to obtain a 
valid license key from Cisco.com within 90 days.

Registering Your License
To register your license:

Step 1 Register the PAK with Cisco.com to get the license file:

• Use this site if you are a registered user of Cisco.com: 
http://www.cisco.com/go/license.

• Use this site if you are not a registered user of Cisco.com: 
http://www.cisco.com/go/license/public.

Note The PAK is printed on the software claim certificate.

The license file will be e-mailed to you.

Step 2 Copy the license file to the CiscoWorks Common Services server with read 
permission for casuser.

Step 3 Enter the license file location from the CiscoWorks home page. (Select 
Common Services > Server > Admin > Licensing. For more information, see 
Common Services online help.)

Upgrading Your Evaluation License
You can upgrade your evaluation license to a registered and licensed copy of 
DFM 2.0. 
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Step 1 Contact your Cisco representative about obtaining a PAK.

Step 2 After obtaining a PAK, follow the instructions in Registering Your License, 
page A-3. The evaluation copy will be converted to a registered copy of DFM 2.0.

Validating Your Upgrade License
Proof of Purchase (POP) is required to validate an upgrade license of DFM 2.0. If 
you purchased an upgrade license, at the end of the DFM installation, you are 
prompted to run a CLI script to validate the upgrade license. The script in turn 
prompts you to do one of the following: 

• Insert the original CD containing DFM 1.2 or DFM 1.2 Updated for Common 
Services Version 2.2.

• Enter login information for a remote server where the previous version of 
DFM (DFM 1.2.x) is running.

To run the script, see Validating the Upgrade, page 3-11.

If you do not run the script or if upgrade validation fails, DFM is licensed for 
evaluation only and operates in nag mode for no more than 90 days before ceasing 
operation. (See Upgrading Your Evaluation License, page A-3.)

Licensing Reminders
DFM provides reminders in the following circumstances:

• Evaluation Version: Before Expiry, page A-5

• Purchased Version: No License File, page A-5

• Restricted Version: Device Limit Exceeded, page A-5
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Evaluation Version: Before Expiry
If you have installed the evaluation version of DFM, you must obtain the license 
file from Cisco.com before expiry of the default evaluation license. For details, 
see Upgrading Your Evaluation License, page A-3.

Before expiry of the evaluation license, see the following prompt for 10 days:

Go to Cisco.com and purchase DFM

This message is displayed as an alert after you log in and try to access DFM. If 
you fail to upgrade your evaluation license after 10 days, all DFM processes will 
run, but access to DFM functionality will be prohibited.

Purchased Version: No License File
If you have installed a purchased version of DFM, you must register DFM using 
the PAK number. For details, see Registering Your License, page A-3. You must 
register DFM within 50 days of installation. If you fail to register DFM after 50 
days, you will see the following prompt:

Go to Cisco.com and get the product registered. 

DFM 2.0 is fully functional. However, you will continue to receive the alert until 
you register your license.

Restricted Version: Device Limit Exceeded
If you have a restricted license, DFM notifies you when your device inventory 
approaches the device limit. After the device limit has been reached, DFM 
displays the following message:

This software has a RESTRICTED license for managing a limited number 
of devices. Please click here for current licensing information. 
Please contact your Cisco representative to determine if additional 
licenses can be purchased for this server. 

DFM 2.0 remains functional, but will shortly stop adding devices to managed 
inventory. 
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How is DFM 2.0 Different from 
DFM 1.2.x?

The differences between DFM 2.0 and DFM 1.2 are listed in the following 
sections: 

• What’s New in DFM 2.0?, page B-2

• Behavior Changes, page B-3

• User Interface Changes, page B-4

• Terminology Changes, page B-9

• Device Group Changes, page B-10

• Protocol Support Updates, page B-11 
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What’s New in DFM 2.0?
DFM 2.0 provides a completely new user interface and many new features:

• Alerts and Activities Display—DFM 2.0 introduces the Alerts and 
Activities display, which provides real-time information about the 
operational status of your network. You can bring up a display and leave it 
running, providing an ongoing monitoring tool that signals you when 
something needs attention. When a fault occurs in your network, DFM 
generates an event or events that are rolled up into an alert. If the alert occurs 
on an element in your active view (a logical grouping of device groups), it is 
shown on your Alerts and Activities display. 

• Fault History—Fault History is installed when you install DFM 2.0. Fault 
History is integrated with:

– DFM Alerts and Activities display—You can launch a Fault History 
report from Alerts and Activities. 

– Common Services Device Center—You can launch a Fault History report 
for a device that you are troubleshooting in the Device Center. 

DFM 2.0 also introduces Search by Group; in addition to searching Fault 
History by device and by alert or event ID, you can search by device group.

• Customizable event names—This feature enables you to change event 
names to names that are more meaningful to you. These customized names 
are reflected in both the Alerts and Activities display and any Fault History 
reports you generate.

More detailed notification messages—When an alert occurs, DFM 
generates an SNMP trap using CISCO-EPM-NOTIFICATION-MIB. The 
SNMP trap format includes the attributes of the alert and the events that 
caused the alert. For more information, see Appendix C, “Notification MIB,” 
in User Guide for Device Fault Manager.

Note The SNMP Trap Notifier MIB is no longer used.

• Easier notification configuration—You can fully configure e-mail 
notification and trap notification from the DFM user interface without the 
need to modify the configuration on the management server. 

• SYSLOG notification—DFM 2.0 adds SYSLOG notification.
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• Additional security—DFM supports:

– SSL protocol between the client and the server.

– SNMP V3 protocol (authNoPriv) between the server and the device.

– Integration with Cisco Secure Access Control Server (ACS).

• Automatic device import—DFM integrates with the Common Services 
Device and Credentials Repository (DCR) and, by default, automatically 
imports devices from DCR. 

• Integration with Device Center—Common Services Device Center is a 
device troubleshooting tool. DFM integrates with Device Center so that from 
Device Center, you can: 

– View active fault details: If there is an active fault, the alert ID is 
displayed on Device Center. You can click the alert ID to open a display 
with event details, alert status, description, duration, and the date and 
time the alert was last updated. 

– Launch a Fault History report for the device. 

Behavior Changes
Discovery

• DFM now pings a device before performing discovery. This has the following 
effects:

– Discovery fails if a device is using a proxy IP. Reconfigure the device 
access level to use ICMP only.

– Discovery fails if a device’s IP is a virtual IP. Reconfigure the device to 
use a valid IP address.

• Discovery of device cards is enhanced because DFM checks the cardTable 
attribute in OLD-CISCO-CHASSIS-MIB.

• DFM does not create interfaces of type ISDN, LAPD, and Other for Cisco 
Access Routers.
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• After you upgrade to DFM 2.0, you will see an increase in the number of ports 
and interfaces that are managed for the following devices:

– Cisco MDS 9000 Series Multilayer Switches

– Cisco SN 5400 Series Storage Routers

– Cisco Catalyst 2950 Series Switches (2950-ST-24-LRE, 2955C-12, 
2955S-12, 2955T-12)

– Cisco Catalyst 3550 Series Switches (3550-24-PWR-SMI and -EMI)

– Cisco Catalyst 3750 Series Switches (3750-stack)

DFM 1.2.x did not create ports and interfaces for these devices because they 
do not support IF-MIB. DFM 2.0 creates ports and interfaces for them 
whether they support IF-MIB or not.

Additional MIB Support

• CISCO-FRAME-RELAY-MIB

• CISCO-PAGP-MIB

User Interface Changes
The DFM 2.0 user interface is quite different from that of DFM 1.2.x. To help you 
access the applications you need to use, Table B-1 lists the click-by-click 
navigation paths you would use to access functions in DFM 1.2.x. Then it 
provides the comparable navigation paths to use in DFM 2.0. 
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Table B-1 DFM 1.2 Navigation Compared to DFM 2.0 Navigation

DFM 1.2.x DFM 2.0 DFM 2.0 Description

Device Fault Manager > 
Administration > 
Administration Console

Device Fault Manager > 
Alerts and Activities

(From the Alerts and 
Activities display, click a 
device to open a Detailed 
Device View.)

From the Detailed Device View, you 
can: 

• View device detail information

• Manage and unmanage devices

• Acknowledge alerts

• Annotate events

(From the CiscoWorks home 
page) Common Services > 
Device and Credentials > 
Device Management

Device Fault Manager > 
Device Management > 
Device Selector

Device management, such as add, 
import, and delete.

Note In DFM 2.0, you import 
devices into a Device and 
Credentials Repository (DCR) 
that is shared by CiscoWorks 
applications. You select devices 
from the DCR (or automatically 
synchronize devices with the 
DCR) for DFM to manage.

Device Fault Manager  > 
Device Management > 
Device Details

View device inventory.

Device Fault Manager > 
Configuration > Polling and 
Thresholds

Configure polling parameters and 
manage thresholds.

Device Fault Manager > 
Configuration > Polling and 
Thresholds > Operations

Reconfigure DFM to use updated 
polling parameters and threshold 
values.
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Device Fault Manager > 
Monitoring Console

Device Fault Manager > 
Alerts and Activities

Alarm display from which you can:

• Launch tools, such as Fault History 
and Common Services Device 
Center

• Export data to a PDF file or a 
comma-separated-values file

• Print data

You can also change the display to 
show the information that interests you 
most, as follows:

• Select and create views or groups 
of device groups; use a view that 
contains the device groups of 
interest to you.

• Filter the display to show alerts 
based on their severity, status, and 
originating device.

Device Fault Manager > 
Administration > Device 
Discovery > Change Probe

Device Fault Manager  > 
Device Management > 
Device Selector

Note The change probe 
process is obsolete in 
DFM 2.0. 

Select devices manually or configure 
DFM to automatically synchronize 
device inventory with Device and 
Credentials Repository (DCR). 

Note Applications on different 
servers can use the same master 
DCR. For more information, 
see User Guide for CiscoWorks 
Common Services. 

Device Fault Manager > 
Administration > Device 
Discovery > Rediscovery 
Schedule

Device Fault Manager > 
Configuration > Other 
Configurations > 
Rediscovery Schedule

• Edit the default rediscovery 
schedule.

• Create additional rediscovery 
schedules.

Table B-1 DFM 1.2 Navigation Compared to DFM 2.0 Navigation (continued)

DFM 1.2.x DFM 2.0 DFM 2.0 Description
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Device Fault Manager > 
Administration > Trap 
Configuration > Trap 
Receiving

Device Fault Manager > 
Configuration > Other 
Configurations > SNMP 
Trap Receiving

Change the port number that DFM uses 
to listen for SNMP traps.

Note Although the SNMP trap 
adapter file used in DFM 1.2 is 
still present in the DFM 2.0 
filesystem, DFM 2.0 does not 
use it.

Device Fault Manager > 
Administration > Trap 
Configuration > Trap 
Forwarding

Device Fault Manager > 
Configuration > Other 
Configurations > SNMP 
Trap Forwarding

Configure hostnames and port numbers 
for trap forwarding.

Note Although the SNMP trap 
adapter file used in DFM 1.2 is 
still present in the DFM 2.0 
filesystem, DFM 2.0 does not 
use it.

Device Fault Manager > 
Administration > Fault 
Notification > File Notifier

— If you need to log events to a file, 
contact the Technical Assistance 
Center for the workaround for 
CSCsa83426.

Device Fault Manager > 
Administration > Fault 
Notification > Mail 
Notifier

Device Fault Manager > 
Notification Services > 
E-Mail Notification

Configure e-mail notifications for 
alarms.

Note Although the mail notifier file 
used in DFM 1.2 is still present 
in the DFM 2.0 filesystem, 
DFM 2.0 does not use it.

Device Fault Manager > 
Administration > Fault 
Notification > Trap 
Notifier

Device Fault Manager > 
Notification Services > Trap 
Notification

Configure trap notifications for alarms.

Note Although the trap notifier file 
used in DFM 1.2 is still present 
in the DFM 2.0 filesystem, 
DFM 2.0 does not use it.

Device Fault Manager > 
Administration > Fault 
History Database Sizing

Device Fault Manager > 
Configuration > Other 
Configurations > Daily 
Purging Schedule

Trim the Fault History database.

Note DFM 2.0 keeps 31 days of 
history and trims the database 
daily at the time you specify.

Table B-1 DFM 1.2 Navigation Compared to DFM 2.0 Navigation (continued)

DFM 1.2.x DFM 2.0 DFM 2.0 Description
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Device Fault Manager > 
Fault History:

• Search by Devices

• Search by Fault 
Conditions

Device Fault Manager > 
Fault History:

• Alert Filtering

– Search Alarm ID

– Search by Device

– Search by Group

• Event Filtering

– Search by Event ID

– Search by Device

– Search Alert ID

– Search by Group

Generate a 31-day Fault History report 
based on search criteria.

Device Fault Manager > 
Alerts and Activities > Tools > 
Fault History

Generate a 24-hour Fault History report 
for all alerts in your current view.

Device Fault Manager > 
Alerts and Activities 

Click an alert ID. The Alerts 
and Activities Detail display 
appears. In the Tools column 
next to the device component 
of interest, select Fault 
History.

Generate a 24-hour Fault History report 
for all events on a device component.

Table B-1 DFM 1.2 Navigation Compared to DFM 2.0 Navigation (continued)

DFM 1.2.x DFM 2.0 DFM 2.0 Description
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Terminology Changes
Terminology has changed since DFM 1.2 as follows:

• Symptom is replaced by event. Events are rolled up into alerts.

• Compound is not used and there is no replacement. A compound differs from 
an alert; there could be multiple compounds on a single device, whereas an 
alert is a roll-up of all events for a device. 

• Levels of device certification (validated, certified, template, undiscovered, 
uncertified) are replaced by new device states:

– Known—The device is successfully imported and fully managed by 
DFM. (Corresponds to validated and certified).

– Learning—DFM is discovering the device. This is the initial state, when 
the device is first added to DFM or is being rediscovered.

– Questioned—DFM cannot manage the device. (Can sometimes 
correspond to undiscovered.)

– Pending—The device is being deleted. DFM is waiting for confirmation 
from all of its data collectors before purging the device and its details.

– Unknown—The device is not supported by DFM. (Corresponds to 
unsupported and uncertified).

• Manage is replaced by Activate; unmanage is replaced by suspend.

• When a DFM 1.2 fault was acknowledged, it was removed from the Alarm 
Log. In DFM 2.0, when an event is acknowledged, it remains in the Alerts and 
Activities display.

• DFM 1.2 assigned devices to groups based on matching criteria. DFM 2.0 
assigns devices to groups based on group rules. 

• DFM 2.0 eliminates the term device class and introduces device type.

• DFM 1.2 displayed managed elements organized by device class—for 
example: Bridge, Host, Hub, MSFC, Probe, Router, RSM, Switch. DFM 2.0 
displays devices organized by device group:

– Inventory device groups are organized by device state.

– Polling and Threshold groups are organized by device type; for example, 
Routers, Switches and Hubs, and Voice and Telephony. (For more 
information, see User Guide for Device Fault Manager.
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Device Group Changes
In DFM 1.2, you could browse the device inventory by selecting a device class. In 
DFM 2.0, you can examine device groups. 

Table B-2 Device Group Changes

DFM 1.2 Device Classes DFM 2.0 Device Groups

Bridge Wireless

Host Cisco Interfaces and Modules

Content Networking

Network Management

Voice and Telephony

Hub Switches and Hubs

MSFC Cisco Interfaces and Modules

Probe Cisco Interfaces and Modules

Network Management

Router Broadband Cable

Cisco Interfaces and Modules

Content Networking

Routers

Security and VPN

Switches and Hubs

Universal Gateways and Access Servers

Voice and Telephony

Wireless

RSFC Cisco Interfaces and Modules

RSM Cisco Interfaces and Modules
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Protocol Support Updates

Switch Content Networking

DSL and Long Reach Ethernet (LRE)

Optical Networking

Routers

Storage Networking

Switches and Hubs

Wireless

Voice and Telephony

Terminal Server Universal Gateways and Access Servers

Table B-3 Protocols

Protocol DFM 1.2.x DFM 2.0

SSL Not SSL-compliant Uses SSL protocol between the server and the browser. 
You enable and disable SSL for the server. See User 
Guide for Common Services.

SNMP • Supports SNMPv1 
and SNMPv2 for 
polling and receiving 
traps

• Forwards traps as 
SNMPv2

• Supports SNMPv1 and SNMPv2 for polling and 
receiving traps. 

• Forwards traps as SNMPv2.

• Partially supports SNMPv3: 

– Uses SNMPv3 protocol between the server and 
the device. 

– Supports the Authentication No Privacy 
(AuthNoPriv) option.

Table B-2 Device Group Changes (continued)

DFM 1.2 Device Classes DFM 2.0 Device Groups
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 P P E N D I X C

Configuring DFM with 
Cisco Secure ACS

This section describes how to configure DFM with Cisco Secure ACS:

• CiscoWorks Login Module, page C-1

• CiscoWorks Server Authentication Roles, page C-2

• Before You Begin: Integration Notes, page C-4

• Configuring DFM on Cisco Secure ACS, page C-6

• Verifying the DFM and Cisco Secure ACS Configuration, page C-6

CiscoWorks Login Module
Common Services provides security mechanisms for authenticating users of 
CiscoWorks applications. You can configure the CiscoWorks login module to use 
one of the following modes of user authentication and authorization:

• Non-ACS—In this mode, the CiscoWorks server provides authentication and 
authorization services.

• ACS—In this mode, a Cisco Secure Access Control Server (ACS) provides 
authentication and authorization services. To use this mode, you must have a 
Cisco Secure ACS installed on your network. The supported versions of 
Cisco Secure ACS for Windows are 3.2, 3.2.3 and 3.3.2.
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If you are using ACS 3.2.3, we recommend that you install the Admin HTTPS 
PSIRT patch: 

1. Go to 
http://www.cisco.com/kobayashi/sw-center/ciscosecure/cs-acs.shtml 

2. Click the Download Cisco Secure ACS Software (Windows) link. You 
will find the link to the Admin HTTPS PSIRT patch in the table.

Note You can integrate DFM with Cisco Secure ACS only if they are installed 
on separate systems because DFM must be configured as an AAA client 
for Cisco Secure ACS. 

In ACS mode, fallback is provided for authentication only. (Fallback options 
allow you to access CiscoWorks if the login module fails, or you accidentally 
lock yourself or others out.) If authentication with ACS fails, CiscoWorks 
does the following:

1. Tries authentication using non-ACS mode (CiscoWorks local mode). 

2. If non-ACS authentication is successful, presents you with a dialog box 
with instructions to change the login mode to CiscoWorks local. (You can 
do so only if you have permission to perform that operation in non-ACS 
mode.)

Note You will not be allowed to log in if authentication fails in non-ACS 
mode. 

For more information, see User Guide for CiscoWorks Common Services and 
Common Services online help.

CiscoWorks Server Authentication Roles
In ACS mode, by default the CiscoWorks server provides the five roles listed here, 
from least privileged to most privileged:

• Help Desk—A user with this role has the privileges to access network status 
information from the persisted data. This user does not have the privilege to 
contact any device or schedule a job that will reach the network. 
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For example, this user can use the Alerts and Activities display. 

• Approver—A user with this role has the privilege to approve all DFM tasks 
and can also perform all the Help Desk tasks. 

For example, this user can search the Fault History database. 

• Network Operator—A user with this role has the privilege to perform all tasks 
that involve collecting data from the network. The user can also perform all 
Approver tasks. The user does not have write access on the network. 

For example, this user can configure logging parameters. 

Note In DFM, a user with this role by default can perform the same DFM 
tasks as a Network Administrator. 

• Network Administrator—A user with this role has the privilege to change the 
network. The user can also perform Network Operator tasks. 

For example, this user can add devices to DFM from the DCR. 

• System Administrator—A user with this role has the privilege to perform all 
CiscoWorks system administration tasks. See the Permissions Report on the 
CiscoWorks server (Common Services > Server > Reports > Permission 
Report). 

For example, this user can configure SNMP trap forwarding 
(Configuration > Other Configurations > SNMP Trap Forwarding). 

Note If you use Cisco Secure ACS to modify these roles, removing tasks or reassigning 
tasks from one role to another, the Permission Report will not reflect your 
changes. 

You can modify roles on Cisco Secure ACS.

Step 1 Select Shared Profile Components > Device Fault Manager.

Step 2 Click the DFM role that you want to modify. 
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Step 3 Select the DFM tasks that suit your business workflow and needs. 

Step 4 Click Submit. 

Note If desired, you can also create new roles on Cisco Secure ACS.

Before You Begin: Integration Notes
This section contains notes that you should read before you begin Cisco Secure 
ACS and CiscoWorks server integration:

• CiscoWorks server and Cisco Secure ACS integration should be performed 
only after installing all LAN Management Solution (LMS) applications.

• If you have installed your application after configuring the CiscoWorks Login 
Module to ACS mode, then the application users are not granted any 
permissions; however, the application is registered to Cisco Secure ACS. On 
the Cisco Secure ACS server, you must assign the appropriate permissions to 
the application.

See Configuring DFM on Cisco Secure ACS, page C-6.

• Multiple instances of the same application using the same Cisco Secure ACS 
will share settings. Any changes will affect all instances of that application.

• If an application is configured with Cisco Secure ACS and then that 
application is reinstalled, it will inherit the old settings.

Note This is applicable if you are using Cisco Secure ACS version 3.2.3 or 
earlier.

• You must create roles in Cisco Secure ACS for each LMS application that is 
running on the CiscoWorks server. 

For example: you must create roles in Cisco Secure ACS for DFM. These 
roles are not shared by any other LMS application. 
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• The roles that you create in Cisco Secure ACS are shared across all 
CiscoWorks servers that are configured to the same Cisco Secure ACS. 

For example: You have configured 10 CiscoWorks servers with a Cisco 
Secure ACS, and you have created a role in Cisco Secure ACS for DFM (say, 
DFMSU). This role is shared by DFM applications running on all 10 
CiscoWorks servers. 

• A user can have different access privileges for different LMS applications.

For example: A user, CWSU, can have the following privileges: 

– System Administrator for Common Services

– Approver for RME

– Network Operator for Campus Manager

– Network Administrator for DFM

– Help Desk for Internet Performance Monitor (IPM)

• On CiscoWorks, you must configure the following:

– Set AAA Mode to ACS—You will need to supply the following 
information obtained from Cisco Secure ACS to complete this task: IP 
address or hostname, port, admin username and password, and shared 
secret key.

– Setup System Identity Setup username.

• On Cisco Secure ACS, you must configure a user with the same username as 
the CiscoWorks server System Identity Setup user. For DFM, that user must 
have Network Administrator privileges on Cisco Secure ACS. 

See the chapter “Configuring the Server” in User Guide for CiscoWorks Common 
Services for details on configuring the CiscoWorks server in ACS mode.
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Configuring DFM on Cisco Secure ACS
After you complete setting the CiscoWorks server to ACS mode with Cisco 
Secure ACS, perform the following tasks on Cisco Secure ACS:

1. Click Shared Profile Components to verify that the Device Fault Manager 
(DFM) application entry is present.

Note If you integrated CiscoWorks Common Services with Cisco Secure 
ACS before installing DFM, you must configure ACS mode again and 
register all applications with ACS. See Common Services online help. 

2. Based on your authentication setting (per user or per group) on Cisco Secure 
ACS, click either User Setup or Group Setup.

On Cisco Secure ACS, verify the per user or per group setting for Device 
Fault Manager using Interface Configuration > TACACS + (Cisco IOS).

3. Assign the appropriate DFM privileges to the user or group.

For DFM, you must ensure that a user with the same name as the CiscoWorks 
server System Identity Setup user is configured on Cisco Secure ACS and has 
Network Administrator privileges.

Verifying the DFM and Cisco Secure ACS 
Configuration

After performing the tasks in Configuring DFM on Cisco Secure ACS, page C-6, 
verify the configuration as follows:

1. Log in to CiscoWorks with the username defined in Cisco Secure ACS.

2. Try to perform tasks, to ensure that you can perform only those tasks that you 
are entitled to perform based on your privileges on Cisco Secure ACS.

For example: If your privilege is Help Desk, then:

– You should be able to view the device summary.

– You should not be able to select devices for DFM to manage.
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3. Based on the Network Device setting for the user or group on Cisco Secure 
ACS, you can view only certain devices on the CiscoWorks server.

Note For a list of DFM displays that perform device-based filtering, see 
DFM-specific online help in Cisco Secure ACS.
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